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Before you start ...

About This Documentation

This documentation applies to version 2020 of the Prinect Manager.

This documentation will give you a brief introduction to operation of the Prinect Cockpit. An example
will also show you how to configure and execute a standard work process.

- Note: The Prinect Manager represents the Prinect Workflow variant with the highest inte-
gration level. Because this documentation was written not only for the Prinect Integration
Manager but also for the Prinect Prepress Manager, the Prinect Pressroom Manager, the Pri-
nect Postpress Manager, the Prinect One Box and the Prinect Digital Front End (DFE), the
general term "Prinect Manager" will be used in this documentation. A specific variant will
be mentioned explicitly only in special cases.

What you should already know

We assume that you are familiar with the Windows” and Mac 0S X®operating systems that are sup-
ported by this application. You should also be familiar with the processes and terms used in a digital
print shop workflow.

Further Documentation

You can find more information in the following documentation:
+ in the enclosed "How to get started" leaflet

« in the Heidelberg Prinect Licensing - User's Guide

« in the Online Help for the Prinect Cockpit
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Before you start ...

Symbols and Styles

The following typographical conventions are used in this manual:

- References to other chapters and sections are blue (on the screen) and underlined.

Example: See "Symbols and Styles", page 8.

- Quotation marks are used to indicate menus, folders, functions, hardware conditions, switch
settings, system messages, etc.

Example: Set the switch to "off".
» Menus, functions and sub-functions are separated by ">".
Example: Select "File > Open...".
- A plus sign is used to indicate that several keys have to be pressed at the same time.

Example: Press Alt+A.

Important Information

Important information in the text is indicated by symbols at the side which are used as follows:

Warning: Contains information that must be taken into consideration to protect the user
from injury.

Caution: Contains information that must be taken into consideration to prevent damage to
hardware or software.

Note: Contains important general or supplementary information about a specific topic.

Prerequisite: Lists requirements which must be fulfilled before the steps which follow can
be performed.

NE R P
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Basic Concept of the Prinect System

The Prinect Manager provides you with all the functionalities for an automated print shop workflow,
depending on the configuration. This workflow covers preparation of the digital job data (documents,
images), proofing and CTP output, monitoring of the print process right up to connection to finishing
of the printed products.

What Components Does a Prinect Manager Workflow Have?

A Prinect Manager is built up on the model of a server-client architecture. The core of the system con-
sists of central components that control all the processes in the system and that regulate communi-
cation flow between the single components. Important basic data like for example, printing materials,
user or customer data, color profiles, are stored in the MDS (Master Data Store). Job processing is
done by "engines".

The user interface of the Prinect Manager is the "Cockpit" that can be installed as a client application
on several computers in the network environment.
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Prinect Manager server PC Additional Cockpit work-
station
Prinect Cockpit Prinect Cockpit
Communication ser- Prinect PDF Toolbox
vices, Master Data
Store

;

Prinect engines,
Renderer

Prinect PDF Toolbox

How do | use the Prinect Manager?

The "Cockpit" is the central user interface for all work that a user does on the Prinect Manager. You
can install this program in a Windows and in a Mac OS X operating system environment. You can per-
form the following tasks in the Cockpit:

- Edit basic system settings (create users and customers, enter spot colors and printing material,
etc.)

- Set up processing steps ("sequences") for automated job processing,

- create jobs, compile job components (input files, sheet layouts), view and monitor jobs, submit
jobs or job data for processing or for approval, check the job status.

A licensed copy of the Adobe Acrobat Professional software must also be installed on each worksta-
tion using the Prinect Cockpit. This software is not included in the shipment of the Heidelberg Prinect
software. The operator of the Prinect software is responsible for seeing to it that Acrobat Professional
is installed on the workstation before installing the Cockpit.

= Note: The Prinect Cockpit is the user interface in which a Prinect Manager is set up and
managed in all its details. Tasks like creating new jobs using preconfigured sequence tem-
plates or monitoring running production processes or operation of the Plate Pilot can also
be done in the "Prinect Portal" WEB User Interface. Details about this can be found in the
Online Help of the Prinect Portal.
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How Does Licensing Work?

Each installation of the Prinect Manager software includes installation of all the software compo-
nents, irrespective of the licenses purchased. The number of options that you can use on a perma-
nent basis is controlled by a license key. The "Prinect Licensing" module controls the enabling of the
options and administration of the licenses. Prinect Licensing consists of two software components,
the License Server and the License Manager. The licenses are enabled online via the Heidelberg
licensing management. As of version 2019 licensing via a dongle is no longer supported. The switcho-
ver to online licensing is also applicable for any version upgrades.

The License Server and the License Manager interact in a "client-server architecture”. Administration
of the licenses is done in the License Server whereas the License Manager depicts the user interface.
Normally, the License Server is installed on the Prinect Manager server. In bigger system environ-
ments with a number of Prinect servers and/or Prinect products, it may be advisable to set up a ded-
icated License Server PC.

= Note: You can find details about licensing in the "Heidelberg Prinect Licensing - User's
Guide" or in the Online Help of the License Manager.

Sequence Templates

In the Cockpit, the processing operations are configured as "sequence templates" that are to run in
the output workflow. By selecting certain preconfigured sequence templates, you can prepare and
output the print jobs in different ways. The option of linking sequence templates lets you run different
output processes, depending on their setup, more or less automatically.

Basic sequence templates

The following sequence types are required for a Prinect Manager basic workflow: "Qualify" sequence,
"Prepare" sequence if required and "ImpositionOutput" sequence. Other types of sequences are avail-
able for advanced workflow options.

- Documents that are in the PostScript format are converted to the PDF format with the Qualify
sequence in a "Normalizing" step. PDF documents are processed by the Normalizer ("refrying")
only if their PDF format is not suitable for processing with the Prinect Manager. At any rate, you
should make sure that the input documents are available as cleansed PDFs suitable for the sub-
sequent processes. In a "Preflight" step, the input documents can be checked, for example, for
the presence of all required fonts, correct image resolution, use of transparency elements, etc.
You can customize the preflight settings to suit your needs.

- After the Qualify sequence, the pages can run through a Prepare sequence. This can be neces-
sary, for example, if you wish to reduce transparency elements found in several layers of a PDF
to one layer. The Prepare sequence also gives you the option of using advanced color manage-
ment options.

- There are several proof options offering a preview of the print result to be expected which you
can use before imaging takes place:

Prinect Manager — Quick Start 1
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- With a "PageProof" sequence, you can print single pages of a document to a page
proofer. Page proofs are mostly used to check the correct color reproduction as a pre-
view of the final product. For this purpose, Color Management that you can configure
especially for this purpose in the PageProof sequence can simulate, for example, also the
colors on the printing material intended for the final product. This means that true-color
page proofing is possible if a suitable calibrated color printer is available.

- With an "ImpositionProof" sequence you can output sheet layouts to a form proofer to
check the imposed sheet layouts. The form proofer can also be used to check color
reproduction if the device is capable of reproducing sufficiently precise colors. For this
purpose, you can also configure Color Management in the ImpositionProof sequence.

« CTP output is set up in an ImpositionOutput sequence.

Group Templates

To configure automated processing, you can group several sequence templates to "group templates”.
In a group template, you can link single sequences by drawing connecting lines between them. These
kind of linked sequence templates can run automatically one after the other without intervention
from the user. You can save different processing setups as different group templates.

Smart Templates

Smart templates are groups of sequence templates that group all the steps required for automated
output workflows ("Smart Automation") as is found, for example, in a web-to-print environment. In
contrast to group templates that are made up of fully setup sequence templates, smart templates
generally just contain placeholders for the different types of sequences that are linked together in the
order they will be processed. These placeholders are characterized only by the sequence type and are
not assigned any parameters when the smart templates are being defined. Only when the job is being
processed are the required parameters sent to the template placeholders. The processing parameters
result from the job properties as defined, for example, in the web-to-print application or in the MIS
(Management Information System).
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Job Processing Workflow

The graphic below shows you a diagram of the basic workflow in processing job files in the prepress
workflow:

—

DTP PDF
file file
Files from a customer or from a are generated as PDF files

design department

Preparation
(Qualify, Prepare)

I . PageProof (with Color Man-
agement) *

Imposition

PDF
file
Page proof

ImpositionProof *

Imposition proof

ImpositionOutput *

CTP output
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1. In a first step, the documents to be printed are saved as PDF files in the DTP application. As a
rule, the customer does this.

2. A new job is created in the Prinect Cockpit when the input files are on hand. This can be done
either directly in the Cockpit user interface or also in the Prinect Portal, in a web-to-print appli-
cation or in the MIS (Management Information System). If you expect a number of print jobs for
a certain customer, you can create a job group where you can group the jobs of this customer.
Furthermore, it is advisable to enter the customer data (name, contact, etc.) into the Prinect
customer administration and assign the new job to the customer.

3. A print job opens in the Cockpit after it is created. You can now check its settings and, if neces-
sary, change them. For example, you can modify single sequence templates or configure color
settings (color order, handling of spot colors, etc.).

4. When you create a new print job, you can at this stage assign sequence templates or a group
template to the job.

After that, the document files are added to the job.
6. Then, processing steps such as page or imposition proof follow.

7. The pages are normally imposed for a CTP output. To do so, the separate pages are assigned to
the page placeholders of an existing layout template. This can occur interactively or automati-
cally.

8. After imposition, an imposition proof can be printed if an appropriate proofer is available.

When the proofs are found to be OK, CTP output of the imposed sheets can be started with the
ImpositionOutput sequence.

- Note: Color proofers and imposition proofers are set up with the "Prinect Color Proof Pro"
software and connected to the Prinect Manager. Linearization and calibration of proofers is
also possible with Color Proof Pro. See also Prinect Color Proof Pro - Online Help.

Platemaking completes the Prepress part of the Prinect workflow. Depending on the configuration of
the Prinect Manager software, additional options for press output and/or finishing can be used apart
from the work steps of a basic workflow.

Set up Customers

- Note: The examples shown in this documentation solely demonstrate operation and must
not be understood as imperative instructions.

In daily work with the Prinect Manager workflow, the edited jobs are normally assigned to the cus-
tomers concerned. For this purpose, the Prinect Manager has its own customer administration. Cus-
tomer data are filed in the Master Data Store and are available at various points in the Prinect envi-
ronment.

Note: Details about customer administration can be found in the Online Help of the Prinect
Cockpit.
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For example, you set up a "virtual customer” to be able to assign a customer to the demo jobs used
in this documentation.

1. Go to "Administration" and click "Customers” (1).

Setfings

Mame:

Customer ID:

Nickname:

Ferson Open...

Cancel

Enter the following customer data:
- Sector: Business
- Name: HD Printshop
- Customer ID: 0001
- Nickname: HDP

3. Click "Open" beside "Person". The "Create Person" dialog opens:
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] Create Person >

Person
Title: (g

First Mame: Williarm
Family Mame: Bauer
MName Suffix:

Additional Mame:

Joh Title:

WillE

Channels

Enter the following personal details:
- Title: Mr.
- First Name: William
- Family Name: Bauer
- Nickname: WillB
- Language: German

These details about the contact are enough for our purposes. In "Communication Channels",
you can enter data such as phone number, mobile number, e-mail address, fax number or Web
address.

Confirm the "Create Person" dialog with "OK".
Then confirm the "Create Customer" dialog also with "OK".

4. The "Customers" window now displays your new customer at the top left of the customer list (1).
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Mark your customer (1) and fill out the "Address" section (2).

- Street: Hauptstrasse 1
- Postal Code: 10111

- City: Berlin

- Region: Berlin

- Country Code: DE

- Country: Germany

5. Confirm your inputs with "Save". Close the "Customers" window by clicking "Overview".

Create a Job

All the elements involved in the processing of documents are combined to form "jobs". You are
prompted to enter the following information when creating a new job:

- Basic job data

- Job Number
You must assign a job number to each job. A job number generally consists of a number
of letters and/or digits. The job number identifies each job in the Prinect Manager. For
that reason, each job must have a unique job number. This is checked when you enter a
new job number. If the job number you entered already exists, the number displayed is
red and you cannot enter any more data until you enter a job number that is not yet
used.
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- Job Name
The job name is the identifier that is used to display a job in the Cockpit user interface.
The job name, too, must also be unique in the system. This means that you must give
each job a job name that is not yet used as a job name in the system. After you enter the
job number, hit the Tab key. The job number is copied automatically to the "Job Name"
box. You can use the job number also as the job name or you can edit this entry.

- Documents
This is where you can assign document files to the job while you are creating a job. To
do this, click "Browse" and select the document files in the file system. You can also skip
this step and add the document files later after the job is created and opened.

- Job Group
Generally, it is advisable to create each job in a job group. This lets you use, for example,
a separate group for each customer you have. If there is a group structure in the system,
the group that you selected before you click "New Job" is entered in this box. By clicking
"Change", you can select a different, available group or create a new group and select it.

- Job Home
In this box, you set the folder in which all the job-specific data will be filed. Normally,
the job files are filed in the "PTJobs" system folder of the Prinect server and there in the
"Jobs" subfolder. A subfolder with the name of the job group is created below the
"PTJobs" folder. A folder with the job name is created in this subfolder. All the job-spe-
cific data are filed in this folder. You must click the lock icon if you do not wish to use
this default. This releases the linking between job group and job folder and you can use
"Change" to select another folder for the job files. We recommend that you do this only
in exceptional cases because the defaults ensure that the job files can be found fast in
the system. The "PTJobs" folder is shared in the network, meaning that the job files can
be accessed by other computers in the system environment, for example, by other Cock-
pit computers. In addition, the central location of all job files facilitates a backup of the
data.

« Customer Data

Assignment of customer data to a job is optional but we strongly recommend that you use the
Prinect customer administration and assign customer data to each job.

- Customer Job ID
The assigned Prinect job number is entered by default in this box. This is where you can
enter customer job numbers in the case that your customers use their own job numbers
that are different to the Prinect job numbers.

- Customer Job Name
Similar to a customer job number, this is where you can enter a different customer job
name.

- Data for processing

In this step, you can assign one or more sequence templates or group sequences to the job with
"Add". By doing this, you define how the job will be processed in the Prinect system. You can
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still edit each of the steps set in the sequence templates after the job is created. This is where
you can save the selected sequences as a template for new jobs generated automatically (see
also chapter "Automatic Creation and Output of Print Jobs in the Hotfolder Mode", page 101).
You can skip this step at this point and assign the required sequence templates later in the open
job.

+ Scheduling data
In this step, you can enter details about the following scheduling data:

- Due Date
You can select a date for the scheduled due date by clicking the calendar icon.

- Job Priority
You can assign a priority to each job. For example, this lets you set that very urgent jobs
are given a higher priority and are processed before other jobs.

- Planned Pages
Generally, the job data or information from the customer tells you how many pages the
job has. Together with the planned amount, you can estimate how big a job will be.

- Planned Amount
The planned amount indicates how many copies of each page will be printed.

The new job is created after you click "Finish".

"PTConfig", "PTJobs", "PTDocs" and "PTTransfer” Folders

In the Prinect workflow, the "PTConfig", "PTJobs", "PTDocs" and "PTTransfer" folders play a key role.
These folders are created during installation of the Prinect Manager software on the Prinect server
PC. Once created, these folders will be shared automatically because they are also used for file trans-
fer within the network. By default, the "PTConfig", "PTJobs" and "PTDocs" folders are write-protected
to protect important system files in them from damage. You can check and, if necessary, correct these
settings in "Administration > Security". You will find more details about this in the Online Help of the
Cockpit.

The "PTConfig" folder contains all the configuration data used in the Prinect Manager. Color profile
files or the Cockpit Installer responsible for installing or updating additional Cockpits on other net-
work computers (Windows and Mac) are also located in the "PTConfig" folder.

All the data belonging to the jobs created in the Prinect Manager are stored in the "PTJobs" folder.

The "PTDocs" folder is designed for (customer) documents that are to be buffered on the Prinect
server before they are added to a Prinect Manager job. Generally, these are PDF documents, image
files, marks and layout templates.

The "PTTransfer" folder is designed for exchanging or filing files that are to be used in print jobs from
the system environment of the Prinect server. This folder is not write-protected.

When you launch the Cockpit and log in to the system, you will be automatically connected to the
"PTJobs", "PTConfig", "PTDocs" and "PTTransfer” folders.
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. Note: On a Mac Cockpit, this connection will take place automatically, but the folders may
not be visible on the desktop. If you wish to access data in these folders from the desktop,
you need to manually mount these folders before you launch the Cockpit. Or, you can
change the finder preferences on the Mac to show mounted network volumes on the desk-
top.

Setup of Presses, CTP Devices and Proofers

To be able to use all required output sequences, you must have set up all the output devices (offset
presses, digital presses, CTP devices, proofers) on the Prinect Manager. The sequence type "Sheet-
fedPrinting" will not be visible in Cockpit if, for example, no offset press is set up in the system.

You set up output devices in different places of the Prinect Manager, depending on the device type.
+ You set up offset presses and digital presses in "Administration > Settings > System". Here, you
can also check whether all other devices are correctly set up in the system.

« CTP devices are set up during installation of Prinect Renderer.

- You set up proofers with the Color Proof Pro software or in Proofing Engine Manager (for "soft-
proof" output only).

Setup of a CTP Device

(Heidelberg) CTP devices that are directly connected are set up by installing the interface card of the
CTP device on the Prinect server PC and installing and setting up the operating software. During the
installation, the CTP device signs on to the Prinect Manager and is entered into the device list.

Data are transferred as Tiff-B files if a CTP device is connected to a special CTP workstation (e.g. to
a Prinect Shooter 2). A special device type, "Tiff-B Export", is designed for this in the Prinect Manager.
Tiff-B files are the complete, screened data of a plate in digital form.

Setup of an Offset Press

To set up an offset press, go to "Administration > Settings" and click the "System" icon. The System
settings screen displays.

20 Version 2020



Introduction

Engine Info
Foot Location:

Warking Location:
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Debug Le

1. Expand the Prinect Server in the tree view to the left and select the "CDM" item.

2. Open the context menu and select "Add Device". The "Device assistant" dialog opens.
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% Device assistant X

General

eet-fed pr
Connection Direct connection of the machine
Contents of operations list Show only workable operations

ding Modes
eduled Only to Jobs
STEIE (|

Assigning functions

O ant

[ mMultiple operator

Performance Parameters

Fixed basic time for setup per operation 20 Minutes

Average Production Speed 10, unitsfh

Maximum Production Spee 8,000 unitsth
Copies

% of the target quantity

Finish

3. Enter a device name and a device ID for the press. These two fields are mandatory. The device
name can also contain press details such as the number of printing units. Complete the other
fields as required. You can edit all entries later on except for those in the "Device name" and
"Device ID" boxes. For more information on how to connect presses, please refer to the Cockpit
Online Help. Click "Next".

22 Version 2020



Introduction

5 Device assistant *

Press selection

Ink tracks HDM plate code

Print start 58.0 Print end

Le nage-free margin 2.5 Right-hand image-free margin
Number of ink zones 5.0 Ink zone width

Plate width Plate length

Minimum sheet width 0 Minimum sheet length

Maximum sheet width Maximum sheet length

Minimum sheet thickness 0.0 Maximum sheet thic
Gripper bite
Control consaole *
Pr I number * 2100
Language English
on 04
Workplace ID * |

Axis Control / Inpress Control
[] Enable import of color data

Finish

4. Selectthe press type in the "Press selection" list box. The appropriate machine-specific data will
be completed automatically.

Select the control station of the press in the "Control console" list box. You can read the press

serial number at the control console or directly at your press. This data is required for the auto-
matic import of inking characteristic curves from the press and/or for Analyze Point (assessment
of color data).

Also select the language and the version of the control console.

The workplace ID is the unique identifier of the workplace in the Prinect Manager. You must also
specify this ID in the data storage configuration of the control console.

When the press has an Axis Control or Inpress Control option, you can enable the "Enable import
of color data" option and select a color data folder. Click "Next".

H Mumber of printing units X
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5. The "Number of printing units" dialog opens. Specify the respective number here — including
any coating units that may be present.

ﬁ Device assistant

MNew printing unit

e EEEEEE

Finish

6. Radio buttons corresponding to the set number of printing units appear where you can specify
the type of printing unit in each case. You can also specify for each printing unit whether or not
a perfector or numbering box is present. You can also delete printing units or add new ones. A
figure of the configured press displays below the options. When you have added or deleted prin-
ting units, you can click the Refresh button to update the view. Click "Next".
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'ﬂ Device assistant

Assigning operation groups

available assigned

Create Operation Group

Back Finish

7. In the "Assigning operation groups" window you define the operation group (cost type group)
available for production data collection. In an operation group, single operations (shop floor
data collection messages) are combined to a group. This gives you a better overview during the
subsequent manual shop floor data collection (PDC) on the press. You can leave the settings
unchanged and continue with "Next" if no special assignment is needed.
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5] Device assistant *

Assigning operations

Function

assigned

Back Finish

8. In the window "Assigning operations”, you assign operations (PDC messages) to the operation
groups selected beforehand. This assignment is necessary for each of the selected roles (oper-
ator, assistant or multiple operator). Then click "Next".
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‘ﬂ Device assistant

Assigning user groups
Function

available assigned

Create User Group

Back Finish

9. In the "Assigning user groups" window, you must assign one or several user groups defined in
the Prinect User Administration to the assigned press operator roles (operator, assistant or mul-
tiple operator). You must assign the "Operator" at least one user group of the "Operator" type,
e.g. "PressOperator”. You must assign an assistant a user group of the "Assistant” type, e.g.
"PressAssistant". You must assign a multiple operator a user group of the "MultiUser" type, e.g.
"PostPressMultiUser". Then click "Next".

Prinect Manager - Quick Start 27



Introduction

% Device assistant X

Create variant

- Create Cost Center

selected modules

Assign variant

Y

= | Modules % | Default
Printing unit

Finish

10. The "Create variant" dialog opens. A variant is understood to mean a press configuration com-
prising individual modules (such as printing unit, dryer, perfector, coating unit). Depending on
the device class of the configured press, different modules are available for assembling a vari-
ant. Define a variant by giving the new variant a name, assigning it a cost center, and selecting
the existing printing units and assigning them to the press. Then click "Next".
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5 Device assistant *

[m]
[m]
[m]
[m]
[m]
[m]
(]
(]
(]
(]
(]
(]
[m]
[m]

Default setup operation
Default production operation
Print
[] Enable Print

Select Printer
Template

Language

11. In the "Summary" window, you can once again check if the press was configured correctly.
Details about the "Pallet sheet" section can be found in the Online Help of the Prinect Cockpit.

12. Click "Finish" to complete the press set-up in Cockpit. The press appears in the tree structure
below the "CDM" item. You can use the context menu command "Edit" to change the configura-
tion settings of the press at a later date.
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-
System

Setting Parameters

Queue:

Queue |dentifier (Dev

JDF HotFolder Path: c6 ConfigUDFHotFolders\C
JMF Connection:

JDF Keeping.

Default JOF Target:

Default JMF Target.

Machines
Name Machine Identifier (DevicelD) Type (DeviceType)
4300 SM 1

3[4 PPF Out
=1 .3 Preflighter
™1\ Recombiner

C1 .\ Timer
C1 ) Trapper

Setting Up a Proofer

You set up proofers for page and/or imposition proof in the Color Proof Pro software. Color Proof Pro
provides the required drivers and color profiles for supported printers and sends all device informa-
tion automatically to the Prinect Manager.

Prerequisite: To set up a proofer, the device must be ready and either connected to the Pri-
nect server directly (e.g. via USB port) or accessible via the network. In addition, the "Color
Proof Pro" option must be licensed.

1. To install a new proofer, launch "Color Proof Pro" in the Windows Start menu or using the
"Search" charm (Windows 8(8.1)/Windows Server 2012 (R2)): Start > [All Programs] > Heidel-
berg Prinect Workflow > Color Proof Pro.
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2. Color Proof Pro opens. Open the "Printer Settings" category on the start page.

m Heidelberg Color Proof Pro Printer Settings
File Settings 7

Installed Devices
Epson Stylus Pro 7300 ~

Settings
Printer Port Wedia Frofiles Special

Device type:
EPSON Stylus Pro 79007910 (P%-Ha000) Contane -

Description

[CIrIP and pint on the fiy

oK

Add... Delete...

Cancel Apply

3. Click "Add". Specify a name for the proofer in the "New output device" dialog (description of the

32

model). The new printer appears in the "Installed Devices" listbox.

Version 2020



Introduction

m Heidelberg Color Proof Pro Printer Settings - *
File Settings 7
Installed Devices

Epson Stylus Pra 3900 CT ~ Add. .. Delete. ..

Settings

Printer Port Media Profiles Sperial

Device type:

EPSON Stylus Pro 99009910 (PR-H10000) Contane

EPSON Stylus Pro 9900/2910 (PX-H10000) HT
EPSON Stylus Pra 3900/9310 (PX-H10000) RGE
EPSON Stylus Pro WT7300fWT 7910 (PX-WE000) Cantane
EPSON Stylus Pro WT7900/WT7910 (PX-WiE000) HT
HP Color LaserJet 9500 {PostScript)

HP Designlet 10501055

HP Designlek 1050/1085(HP-RTL)

HP Designlet 10ps/20ps/S0ps

HP DesignJet 120 Series

HP Designlet 130 Series

HP DesignJet 30 Series

HP Designlet 4000 CT

HP Dresignlet 4000 HT

HP Designlet 4020 CT

HP Designlet 4020 HT

HP Designlet 4500 CT

HP DesignJet 4500 HT

HP Designlet 4520 CT

HP Designlet 4520 HT

HP DesignJet S000

HF Designlet 510 (24 inch)

HP Designlet 510 {42 inch)

HP Designlet 5500 (42 inch)

HP Designlet 5500 (60 inch)

HP Designlet 800 {24 inch)

HP Designlet 800 (42 inch)

HP Designlet 90 Series

HP Designjet T1100 {24 inch) CT

HP Designjet T1100 (44 inch) CT hl

QK Cancel Apply

4. Select the device type of the connected printer in the "Device type" list box. In "Description” you
can specify a description of the printer.

5. Go to the "Port" tab.
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m Heidelberg Color Proof Pro Printer Settings - X
File Settings 7
Installed Devices
Epson Stylus Pro 2900 CT ~ Add... Delete...

Settings
Printer Part Media Profiles Special

Prink ko systemn printer

Mickosaft ¥PS Document Wiiter

(®) Print via network
IP address

2 10.51.202.249 Test

Used TCPJIP protocal
@ RAW on pork:

100

O LPR. queue:

O Print wia port

-no port available-

ok Cancel Apply

6. This is where you define how the proofer is connected to the Color Proof Pro software:

- if the proofer is connected to the Prinect-Server as Windows system printer, enable the
option "Print to system printer" (1). The printer is available in the list of system printers
and must be selected.

- Enable the option "Print via network" (2) if the proofer has a network interface and is
accessible in the network. In this case, the IP address of the proofer must be known to
you (ask your system administrator if necessary). Most printers can display their own IP
address, for example by printing a configuration sheet (accessible in the Settings menu
of the printer). The "RAW on port" option is enabled automatically. You can leave the
"9100" entry unchanged in most cases.

Click "Test" when you have specified the IP address. Color Proof Pro will the try to estab-
lish a connection with the specified network address. Use the network address only if the
test was successful.

- If the printer is controlled via the "LPR (Line Printer) protocol”, you must enable the
"LPR" option and specify the queue name.

- If the printer is connected to the Prinect Server via a local port but is not configured as
system printer, you must enable the "Print via Port" option and select the appropriate
port.

Then click "Apply".
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7. Go to the "Profiles" tab. In this tab, you can install output color profiles for the different printing

materials.
m Heidelberg Color Proof Pro Printer Settings - *
File Settings 7
Installed Devices
Epson Stylus Pra 3900 CT Add. . Delete. ..
Settings
Printer Port: Media Profiles Special
Installed Profiles
Printer Media Resolution: Ink Media type Profile: EFL Directory [l
EPSON Stylus Pr.,,  BEST eXpressP... 720 x 720 Epson Ulkrachr,..  Epson Proofing ... SP#900CT_720... $PAPER)Epso... \EpsomiStylus ...
EPSON Stylus Pr...  EFI Budget Pro... 720x 720 Epson Ulkrachr,..  Epson Proofing ... SP#900CT_720... ${PAPER)Epso... \EpsomiStylus ...
EPSON Stylus Pr.,.  EFI Cert Proof ...  720x 720 Epson Ulkrachr,,.  Epson Proofing ... SP?900CT_720... ${PAPER)Epso... \EpsomiStylus ...
EPSON Stylus Pr...  EFI Flexo Proof...  720x 720 Epson Ulkrachr,,.  Epson Proofing ... SP?900CT_720... ${PAPER)Epso... \EpsomiStylus ...
EPSON Stylus Pr...  EFI @ravare Pr... 720720 Epson UlkraChr,..  Epson Proofing ... SP2300CT_720... $PAPER)/Epso... \EpsomiStylus ...
EPSON Stylus Pr...  EFI Offset Proo... 720x 720 Epson UlkraChr...  Epson Proofing ... SP7900CT_720... ${PAPER)/Epso... .\EpsomiStylus ...
EFSON Stylus Pr...  EFI Offset Proo... 720 x 720 Epson UltraChr...  Epson Procfing ... SP9900C_720x... ${PAPER)/Epso... .\EpsomiStylus ...
EFSON Stylus Pr...  EFIFPhoto Class,..  720x 720 Epson UltraChr...  Epson Proofing ... SP9900C_720x... ${PAPER)/Epso... \EpsomStylus ...
EFSON Stylus Pr...  EFIFPhoto Fine...  720x 720 Epson UltraChr...  UltraSmooth Fin... SP9900CT_720... §{PAPER)/Epso... \EpsomiStylus ...
EFSON Stylus Pr...  EFIFPhoto Fine...  720x 720 Epson UtraChr...  UltraSmooth Fin... SP9900CT_720... §(PAPER)/Epso... \EpsomiStylus ...
EPSON Stylus Pr...  EFI Photo Pape...  720x 720 Epson Ulkrachr,..  Epson Proofing ... SP#900CT_720... $PAPER)Epso... \EpsomiStylus ...
EPSON Stylus Pr...  EFI Photo Pape...  720x 720 Epson Ulkrachr,..  Epson Proofing ... SP#900CT_720... $PAPER)Epso... \EpsomiStylus ...
EPSON Stylus Pr...  EFI Production ...  720x 720 Epson Ulkrachr,..  Archival Matte .., SP4900CT_720... ${PAPER)Epso... \EpsomiStylus ...
EPSON Stylus Pr...  EFI Production ... 360 x 380 Epson Ulkrachr,..  Enhanced Matt,.,  SP9900CT_36x... $PAPER)Epso... \EpsomiStylus ...
EPSON Stylus Pr...  EFI Production ...  720x 720 Epson UlkraChr,..  Enhanced Matt,.,  SP=900CT_72x... $PAPER)/Epso... \EpsomiStylus ...
EPSON Stylus Pr...  EFI Production ...  720x 720 Epson UlkraChr...  Enhanced Matt...  SP4900CT_720... ${PAPER)/Epso... .\EpsomiStylus ...
EPSON Stylus Pr...  EFI Production ... 1440 x 1440 Epson UlkraChr...  Epson Proofing ... SP3300CT_144... ${PAPER)/Epso... .\EpsomiStylus ...
EFSON Stylus Pr...  EFI Production ...  720x 720 Epson UltraChr...  Enhanced Matt... SP4900CT_720... §{PAPER)/Epso... \EpsomiStylus ...
EFSON Stylus Pr...  EFI Produckion ... 720 720 Epson UitraChr...  Epson Proofing ... SP9900CT_720... ${PAPER)/Epso... \EpsoniStylus ... b
[shiow all profiles Install profiles Import profile Delete prafile Refresh list
QK Cancel Apply

8. Click "Install." The Installer for the proofer profiles starts. This Installer installs the pre-config-
ured printer profiles included in the shipment. Wait until installation is finished. The installed
profiles appear in the "Installed Profiles" list. Click "Refresh list" if the new profiles you installed
do not appear.

- Note: For accurate color reproduction, it is essential that you run characterization sepa-
1 rately for each proofer with the Color Proof Pro software and that you create custom profiles
for the printing materials used, for example, with the Prinect Color Toolbox. You can assign
these profiles to the printer with "Import". You will find details about these topics in the "Pri-

nect Color Proof Pro — User's Guide” or in the Color Proof Pro Online Help.

Installation of the proofer in Color Proof Pro is now complete. Confirm installation with "OK".
The "Printer Settings" close, and the start page of Color Proof Pro Engine Manager appears. Click

"Finish".

9. You must exit the Cockpit if the Cockpit user interface was open during installation of the
proofer. Following that, you must exit and restart the Prinect services with the Prinect Mainte-
nance Center. The new proofer can then be seen in "Administration > System" when you restart

the Cockpit:

Prinect Manager - Quick Start
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«J JoblmExporter

«J Messenger

«J Normalizer

«J PDConnect

«J PDFCompare

£% PPF Out

« Preflighter

«J Recombiner
= ) Renderer
Default_Tiff-B_Export

us Pro 11880 Ct

_Designjet_5500
JPEG Export
PDF Export

stScript Export

Proof

setter 145

setter_A74
TIFF Export
4 ResponseHandler
4 TiffBHandler
w) Timer
wJ Trapper
]

10. In "Administration > System", click the small triangle preceding the "Renderer" item in the tree
view. The proofer you installed is shown there.

You can now select the configured proof devices as output device in the respective output sequence
to generate the desired output in the Prinect workflow.

Create Printing Material

In Prinect Cockpit, you can store the properties of different printing materials required for offset prin-
ting as data records. You can assign the printing material defined in this way to each of the print jobs.
This information is suitable for planning or billing purposes.

1. Go to "Administration" and click "Printing Materials and Substrates" in "Resources".
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2. The "Printing Materials and Substrates" view opens. There is a separate tab for printing materi-
als and for substrates (printing materials for digital printing). Click the "Create Printing Material"
button in the "Printing Materials" tab. The "Create Printing Material" dialog appears. Complete
the fields as shown the screenshot below:

Edit Printing Material *

Edit Printing Material

Brand: Kondor G

AT49146

Group: HD_Printing
Width / Height [mm]: 360

Costper 1000 she

Active for Automati Yes

Grain Direction: Short grain
Feed Direction: Long Edge

bstrate:

Paper Grade {
Type of Printing Material for Calibration:

L*a*b*

Thick mmyj:

Grammage [g/m~]:
Type of material:
Ink Consumption Factor [%]:

Quality:

3. Click "OK". The printing material entry is saved and shown in the list:
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A
c‘-", Printing Materials and Substrates

Substrates

T— | Group % Width/Height Unit | mm - Entries |6 Standard

Group + | Brand + | Article Number + | Substrate + Costper1000 sheets F
P Group : Category Labelfire (1) =
w Group: HD_Printing n

HD_Printing G AR

P Group:Vers

Create Printing Material... Substrate from Printing Material... Properties... Duplicate

As the group name "HD_Printing" was specified for the printing material, it is part of this group.
You can define any other group of printing materials in this way.

Click "Save" to save the new printing material you created. The printing material is saved to the
Master Data Store (MDS); this means it is available throughout the entire Prinect Manager envi-

ronment and can be used to set up a print job, for example. Click "Overview" to return to the
Administration master page.

Configure Sequence Templates

To configure the sequence templates needed for the examples below, proceed as follows:

1. Go to "Administration" and click "Templates".
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B

Product Types

2. The "Templates" view opens. Click the folder icon beside "Sequence Templates" to display the
single sequence items.

Configure a Qualify Sequence

_t' Templates

Active Criterion Machine Created on Create... Date Modified

B3 ¢ PDFEGit
1 P Prepare

endBookletPDF

endimposedPDF

81 # BookletProof

1. Highlight the "Qualify" sequence type (1) and click "New" (2).

The setup section for a new Qualify sequence opens:
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Overview r Templates

Untitled (Qualify)

" | AllPreflightimports

put is

Set this sequence as follows:

2. Leave "CEPS Conversion", "Normalizing", "Recombiner”, "Split Document", "Automatic Page
Assignment”, "Combine Documents" and "Destination" disabled or as they are.

Enable "Hotfolder" and leave the defaults as they are.

4. Mark the "Preflight" option and display the parameters by clicking the small triangle before the
checkbox.

5. Click "Browse" in the "Heidelberg Preflight Profile" section of the "Actions" tab (1). Select the
"OffsetDefault.hpp” profile.

& Preflight ) AllPreflightimports -

Advanced Reporting Document Images Fonts Fonttype Colors Separations Content Complexity
Heidelberg Preflight Profile

ard Heidelberg Prefiignt Profile for offset printing. No page contents comections.

PitStop Prefiight Profile and Action Lists
[0 Pitstop preflight profile Defaultppp
PitStop Action Lists

Fonts

[ Ignore System Font Folders
Font Search Folders

6. Click "Save as":
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T Save Template *

O  Qualify

Template Name: | qyalify HDCity

Comment:

Customer ID: 0001
Product Codes:

Product Types:

7. Type in "Qualify_HDCity" as the name and select "HD Printshop" as the customer with "Edit" in
"Customer ID". Confirm the "Save Template" dialog with "OK".

8. Click "Close". The sequence overview displays.

Configure a PageProof Sequence

1. Highlight the "PageProof" sequence type and click "New".

The setup section for a new PageProof sequence opens:
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Overview .i' Templates

Untitled (PageProof)

[ Printing unit2 I, printing unit gunit [ Tool Proof  [4] External

Outputis

Set this sequence as follows:
2. Leave "Color Conversion", "Split Document”, "Layout Preparation”, "Proofing, "Approve Page"
and "Destination" disabled or as they are.

Edit the following options in the "Imposition" step:

Choose "Scale Down to Fit on Media" in the list box "When Media Too Small".

4. Enable the "Color Bar" option and here the "Standard Marks" option, and choose the mark type
"HD Proof". Also enable the option "Use Colormatching for the Color Bar".

5. Leave all other settings of this step unchanged.

Edit the "Rendering" step as follows:

6. Leave the settings in the "Device" section unchanged.

7. Enable the "Proof Color Management" option and set up parameters as follows:

Proof Color Management
Fre Browse...

Color Handling

8. Save the sequence template as "PageProof HDCity" (with customer assignment) and close the
window.
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Configure an ImpositionProof Sequence

1. Highlight the "ImpositionProof" sequence type and click "New".

The setup section for a new ImpositionProof sequence opens:

Overview .:' Templates

Untitied (ImpositionProof)

tingunit ] Coatingunit [ Tool  [4] Proof  [] External

Outputis

Set this sequence as follows:

2. Leave "Accept approved pages only", "Color Usage", "Color Conversion”, "Marks Replacement”,
"Ink Consumption Calculation", "Approve Imposition" and "Destination" as they are.

Edit the following options in the "Imposition" step:

Choose "Scale Down to Fit on Media" in the list box "When Media Too Small".

Enable the "Color Bar" option and here the "Standard Marks" option, and choose the mark type
"HD Proof". Also enable the option "Use Colormatching for the Color Bar".

5. Leave all other settings of this step unchanged.

Edit the "Rendering" step as follows:

6. Leave the settings in the "Device" section unchanged.

7. Enable the "Proof Color Management" option and set up parameters as follows:

Proof Color Management

Browse...

Color Handling
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8. Leave the settings for the "Proofing" and "Destination" steps unchanged.

9. Save the sequence template as "ImpositionProof HDCity" (with customer assignment) and close
the window.

Configure an ImpositionOutput Sequence

1. Highlight the "ImpositionOutput" sequence type and click "New".

The setup section for a new ImpositionOutput sequence opens:

Overview 1' Templates

Untitled {ImpositionOutput)
[0 & Acceptapproved surfaces only
PN

Color Usage: PrintingUnit  [] Printing unit 2 Spedial, printing unit Coatingunit  [J Tool [ Proof [ External

[J & ColorCo

AllMarksReplacers

»
13
»
»
»
»
»
»

Suprasetter_A105 on KIE-C

¥ Destination Outputis

Set this sequence as follows:

2. Leave "Accept approved surfaces only", "Color Usage", "Marks Replacement”, "Calibration",
"Sheet Preview Generation”, "Thumbnail Generation", "Halftone Soft Proof", "File Output",
"Image Setting", "Plate Approval" and "Destination" disabled or as they are.

Enable "Color Conversion" and set the following options:

4. Set up the parameters in the "Document" tab as follows:

-

Document
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5. Set up the parameters in the "Color Management" tab as follows:

Browse...

* [ 9 Colo J AllRendererColo

Document 0
Device Dependent Colors

Rendering Intent
Perceptual
Perceptual
Perceptual

Perceptual

lanagement

e e o Y Y 3 [ S

gement

7. Leave the settings in the "Overprint" and "Advanced" tabs unchanged.

8. Select the installed CTP device (in the example Suprasetter_A_105) in the "on" list box of the
"Imposition” step. This setting will be adopted automatically for all steps using this engine type.

9. Edit the following options here:
10. Choose "Scale Down to Fit on Media" in the list box "When Media Too Small".
11. Leave all other settings of this step unchanged.

12. Configure the "Rendering" step as follows:
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In this step, you should be especially careful in "Plate " (1) to select a material matching the
dimensions of the defined sheet layout. In our example, the layout is set up for a Speedmaster
52 with a size of 525.0 x 459.0 mm. This is why "SM52" was selected as the material name.

Leave the "Printer/ECI offset 2007/1SOcoated_v2_eci.icc" default in the "Press Profile" (2) sec-
tion unchanged. Also leave the options "Use Press Profile from Job Settings, if available" and
"Use Embedded PDF/X Output Intent, if Available, as Press Profile" enabled.

Leave the item "1 glossy coated" selected in "ISO Papertype" (3) of the "Press" section
unchanged.

13. Configure the "Screening" step as follows:

Angle Substitution

creening from PDF Tools

14. Save the sequence template as "ImpositionOutput_HDCity" (with customer assighment) and
close the window.

Configure a SheetfedPrinting Sequence

1. Highlight the "SheetfedPrinting" sequence type and click "New".

The setup section for a new SheetfedPrinting sequence opens:
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Overview ,x' Templates

Untitied (SheetfedPrinting)

O

2. Make sure that in "Printing" the "SM52-8P-3L" press is set in the "on" list box. Leave all other
options unchanged.

3. Save the sequence template under the name of "SheetfedPrinting_HDCity" (with customer
assignment) and close the window.

Create a Group Template

For the processing of a job it is not absolutely necessary to create a group template but the use of
group templates facilitates the processing of further print jobs that need similar processing steps. A
group template will be created to illustrate how you define and use a group template.

1. Mark "Group Templates" in the sequence overview and click "New".

The empty setup window of a group template opens.
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,t Templates

Add Template

Saveas..

2. Open the "Qualify" folder and select "Qualify_HDCity" (1). Double-click the item or click "Add
Template" (2).

An icon for the Qualify sequence is created in the workspace.
3. Repeat step 2 for the "PageProof_HDCity", "ImpositionProof_HDCity", "ImpositionOutput_HDC-
ity", "SheetfedPrinting_HDCity" sequences.

The workspace now displays as follows:

.t Templates

Name: Unlitied

F
<
|2 Sheetredprinting_H...

Add Template

4. Inthe workspace, select "AutoArrange" in the context-sensitive menu. The icons are placed side
by side and aligned.
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5. Now link the "ImpositionOutput_HDCity" and "SheetfedPrinting_HDCity" sequences by clicking
the sheet icon to the right of the "ImpositionOutput_HDCity" icon and, with the left mouse but-
ton pressed down, drawing a line to the "SheetfedPrinting_HDCity" icon and then letting go of
the mouse button (drag-and-drop). Connecting both sequences will cause these sequences to be
automatically executed in succession during job processing.

Name: Group_Template_HDCity

0 0 g O ® g e

We will not add any other links between the other sequence icons because we are not going to
configure a fully automated workflow here. Both proofing sequences interrupt the final output
workflow because CTP output and offset printing are only after the proof results have been
assessed.

6. Save the group template with "Save as" as "Group_Template_HDCity" and close the group tem-
plate window.

All the sequence templates needed for a basic workflow are now configured.
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Manual Creation of a Print Job

In this example we will show you how to process a 36-page booklet "HDCity" with the Prinect Mana-
ger. Later we will show you how new print jobs are created automatically in the "Hotfolder" mode
(see section "", page 101).

" Note: The examples shown in this documentation solely demonstrate operation and must
not be understood as imperative instructions.

Storing Job Documents on the Prinect Manager Server

For our sample booklet, we are going to edit and output suitably prepared PDF files as document files
containing the content pages of "HDCity" in German and English.

1. To open the documents (and sheet layouts) faster later, we will create a new "Testjobs" folder
in the "PTDocs" folder on the Prinect server (see section ""PTConfig", "PTJobs", "PTDocs" and
"PTTransfer” Folders", page 19).

2. In this folder, create a subfolder named "HDCity-36Pages-A4" and there two subfolders named
"Layout” and "PDF". The folder structure is now as follows:
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| B = | E\PTDocs\Testjobs\HDCity-36Pages-A4 - O X
Home Share Wil o
x u o cut x I News item ~ D open - FB selectall
Wl Copy path ﬂ Easy arccess » Edit Select none
Fin to Quick Copy  Paste Mowve  Copy Delete Rename Mews Properties .
access [F] Paste shortout | tq to - folder © £ ivert selection
Clipboard Organize Mew Cipen Select
&« « 4 » ThisPC » E_Data(E:) » PTDocs » Testjobs » HDCity-36Pages-Ad » v | & Search HDCity-36Pages-Ad P
- D_Temp (D) A Name Date modified Type Size
v = EData(E) Layout 6/23/201711:02 AM  File folder
SRECYCLE.BIN PDF 6/23/201711:02 AM  File folder

Commaon Services
db_backup
GPI
HD_Service
Installer
Prinect Portal Data
PTConfig
PTDocs
CxF-Dateien
Export
External_HF
PDF-Marks
Testjobs
dup_FB_ID_Submit
BusinessCards
data
Diverse
Golfstory-16Pages-5C-A4
HD_City_Brochure
y HDCity-36Pages-Ad

State:a Shared

2iterns

3. Copy the "HDCity.pdf" to the "PDF" folder.
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(e = | E\PTDocs\Testjobs\HDCity-36Pages-AMPDF — O ¥
Hame Share Wi 0

D # Cut X ':‘J e itern - ﬂ Dpen HHSelectall

] Copy path T | Easy access - Edit Select none
Finto Quick Copy  Paste Move  Copy Delete Rename Mew Properties

access | Paste shortout to to falder DD Imvert selection

Clipboard Crganize e Cpen Select
&« v » ThisPC » EData(E) » PTDocs » Testjobs » HDCity-36Pages-A4 » PDF v | O Search PDF y

-

s E_Data (E:) & Mame Date modified Type Size
SRECYCLEBIN = HD_City.pdf 6/23/2017 11:14AM  Adobe Acrobat-D.. 174,304 KB
Common Services
db_backup
GPI
HD_Service
Installer
Prinect Portal Data
PTConfig
PTDocs

CxF-Dateien

Export

External_HF

PDF-Marks

Testjobs
dup_FB_ID_Submit
BusinessCards
data
Diverse
Golfstory-16Pages-3C-Ad
HD_City_Brochure
HDCity-36Pages-Ad
HOTest-20Pages-4C-Ad

1item State:az Shared 5

Creating a Layout

We are going to use Prinect Imposition Editor to create the sheet layout. Imposition Editor is part of
PDF Toolbox that is installed on the Cockpit computer as an Acrobat plug-in during installation of the
Cockpit.

" Note: For more details on the Imposition Editor, please refer to the Online Help of Prinect
PDF Toolbox. You can invoke Help in Acrobat with the menu item "Help > Plug-In Help > Pri-
nect PDF Toolbox 2020".

Licensing PDF Tools

Before using the Prinect PDF Toolbox applications for the first time, you may have to request a license
for each of the program modules from Prinect License Server, if this is not set by default during instal-
lation. A floating license for PDF Toolbox comes along with the license key for the Prinect Manager.
To license the PDF Toolbox, you need the name of the computer on which the License Server is
installed.
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1. Open Acrobat Pro on the Prinect Server and go to "Plug-Ins > Prinect 2020 > Licenses".

Prinect PDF Toolbox 2020 - Licenses

., PDF Assistant Geometry Control

. PDF Assistant Separation Control
p:. PDF Assistant Show Layout Pages
f. PDF Aszistant Register Control
p:_ PDF Assistant Assemble Pages
7 PDF Assistant POF Report

1 PDF Assistant Fast View

p:_ PDF Assistant POF/WT Control
f. Color Editer Color Management
p:. Color Editer Spot Colors

p:_ Color Editor Multicoler

f. Coating Editor

f_ Trap Editor Automatic Trapping
i Trap Editor Edit

1 Object Editor

p:_ POF Compare

% Barcede & VDP Editor
f. Versioning Assistant
p:_ Imposition Editor 52

f. Imposition Editor 75

« Imposition Editor 106 e

Release

License Server

State

95999 installed
9995 installed
5959 installed
95999 installed
9995 installed
9999 installed
9995 installed
55995 installed
95999 installed
9995 installed
5599 installed
95999 installed
9995 installed
5959 installed
95999 installed
9995 installed
9999 installed
9995 installed
55995 installed
95999 installed
fleating

Request

Name |[TIE -, o

service

Werify

License Server '=a -m " available
Select the product to request a license

2. Inthe "License Server" (1) box, type the name of the License Server computer (e.g. the Prinect
server where the basic Prinect Manager software is installed). The message pane (2) displays a

confirmation when the License Server has been detected.

3. Mark the items in the list of tools to be licensed (minimum is an "Imposition Editor" license) and
click "Request". When the appropriate license is found, the licensed item is tagged by a green
checkmark (3). You can also highlight several PDF Toolbox tools at the same time and request

their licenses.
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Manual Creation of a Print Job

later stage into the Prinect Manager workflow as an imposition template. The Imposition

Note: The layout we want to create with the Imposition Editor here is to be imported at a

Editor can create importable layouts only if no PDF file is open in Acrobat or Imposition Edi-

tor.

1. Open Acrobat Pro on the Prinect Server and select "Plug-Ins > Prinect 2020 > Imposition Editor
> New Layout" — without any document being open.

B8 Adobe Acrobat Pro DC — [} e
File Edit View @ Window  Help
Home To¢ Prinect 2020 » PDF Toolbox » ‘ ® Bernd ~
Imposition Editor r [ Mew Layout
Recent
Open Layout...
| MyComputer | Akernste Images Fact View On/OF
Document Cloud
Add Account Versioning Assistant...
PDF/NT Control..
Import/Export...
CFF2 Defaults...
Licenses...
2. Imposition Editor starts with default settings.
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56

B Mew Layout - Prinect PDF Toolbox 2020 Imposition Editor - [m] *

= =R L

= i . = | 5=
B ¢ = i S
Plate Format Width Height

Printing Material Width Height

<] [ove] (o

Position ¥ Position Y

Horizontal center [/] ~ 12.500 49.000

Folding Sheet Position Position X Position

<] oo [oom|

Placement Rule

35x50

Center

Turn ~

pans [

AutoApply Apply

Show Transparency

() Front 2]
(") Back

v (®) Front and Back

' - - =

You must now edit the layout so it matches the conditions of the Prinect workflow.

First, set a plate size that matches the press size: In the "Plate Size" list box (1), select "SM52"
if a Speedmaster 52 press is going to be used for printing, like in our example. You can also
select another machine if a different type of machine is used or select "User-defined" and match
the plate size accordingly. Set the plate dimensions as follows:

- Width: 525,000
- Height: 459,000

Now set the size of the printing material and select "35x50" in the "Printing Material" list box

(2):
- Width: 500,000

- Height: 350,000
Leave the "Horizontal center" option enabled.

Leave the setting "Center" in the "Folding Sheet Position" list box (3) unchanged.

Leave the setting "Sheetwise" in the "Placement Rule" list box (4) unchanged, and also the
options "Auto Apply" and "Front/Back".
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7. Choose "36" as the number of pages (5).

8. Go to the "Marks" tab.

Manual Creation of a Print Job

7 Mew Layout - Prinect PDF Toolbox 2020 Impesition Editor

HAWE| QR < o F[@|m

- m} x
?
& ¢ = A= =8
Offsst  Length =+~
2 Folding Sheet Cuts
S,
ol Marics
s
ottt 2000
S | ES | O N
[ Color Bar Orfset
RS TS Y —++=
L
[ Pull Lay Front Back “Y+
e
[[] collating Mark Length 4=
| Automatic v| | doss3|[ 1784
Pages [ _]f]
a0
Show Transparency
() Front m-
() Back
(® Front and Back 0

9. Enable all the marks types in the upper area (1): Folding Sheet Cuts, Cut Marks, Folding Marks,
and Lay Marks Leave the mark details "Offset", "Length" and "Width" unchanged.

Leave the "Ink Pickup Bar" and "Color Bar" options disabled.

Leave the "Register Marks", "Pull Lay" and "Collating Mark" options disabled.

Leave the options "Auto Apply" and "Front/Back" enabled.

10. Go to the "Master Pages" tab.

Prinect Manager - Quick Start

57



Manual Creation of a Print Job

|87 New Layout - Prinect PDF Toolbox 2020 Imposition Editor - [m] *

HAW A = o/ |@|m

& s 6= |

Master Pages

(et v|[+]E

Page Size Width  Height
|From PoF v | [210.000] [ 297.000]

Orientation Page Policies
Pt

Trim Allowance for Pages

o [ i tion of Trim

Left Right: On even Pages

[/] Swap Left/Right

Upper Lowver

[ | Swap Top/Bottom
@ o=

Pages [35 |
B tosony e
Show Transparency
() Front 2] »
() Back
(@) Front and Back =

Leave the settings "From PDF" in the "Page Size" listbox, "Width", "Height" and in the "Page Pol-
icies" listbox " (= Center) (1) unchanged.

Leave the option "Automatic calculation of Trim Allowance" (2) in the "Trim Allowance for
Pages" area enabled and specify a value of 3.000 mm for "Bleed" (3).

Leave the options "Auto Apply" and "Front/Back" enabled.

1. Go to the "Scheme" tab.
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|87 New Layout - Prinect PDF Toolbox 2020 Imposition Editor - [m] *

HQW A« 0| @|mm

Scheme

s 2
_— e[|
Master Pages Ordinal Orientation
[+ I+

Front [ Back
peges [}
B tosony e
Show Transparency
() Front 2] »
() Back
(@) Front and Back =

12. In the "Scheme" (1) area, select the "F4-12x1" scheme. In this scheme, two document pages are
placed on each surface (front and back), arranged in two columns and one row. As the docu-
ment loaded in our example contains only two front and two back pages each, the screenshot
also only displays two pages each per surface.

In the "Master Pages" area (2), leave the "Default" setting as it is.
The graphical preview (3) shows how the pages are arranged. Leave the "Back" option enabled.
Leave the options "Auto Apply" and "Front/Back" enabled.

13. Go to the "Layout" tab.
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B Mew Layout - Prinect PDF Toolbox 2020 Impasition Editor - ] x
HQW[ AR = 0/ [@m -
A v @ 52 &8
o | e
Binding Method Creeping Value
o |° _nre o o Saddiestich v m e
Gripper Collator
Mot existent w 0.000
56 ] @ 12 553 Press Sheet Layout
AutoArrange Folding Shests
Collate, cut and stack
P4 0 -
Columns | 1 = Repeat
Rows 1 = Repeat
+..
. | 0000 %* | 0000
{34 ] (3]
e
AutoApply Apply
L
Show Transparency
() Front 2l
() Back
P | Y R . ., Av (®) Front and Back
< > m

Leave the setting "Saddlestitch" in the "Binding Method" list box (1) unchanged.

Specify a creeping value of 0.200 mm. Leave the icon for moving the cut marks (2) unchanged
(for saddlestitching, the cut marks are moved accordingly).

As our sample configuration does not include a saddlestitcher, you must leave the entry "None"
in the "Gripper Collator" listbox unchanged.

Enable the option "AutoArrange Folding Sheets" in the "Press Sheet Layout" (3) area.
Leave the options "Auto Apply" and "Front/Back" enabled.

14. The definition of the layout template is now complete. You must now save the layout template.
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|87 Mew Layout - Prinect PDF Toolbox 2020 Imposition Editor

HQW| AN« 8| [@|m

Click one of the buttons "Save job" (1) or "Save job as" (2). A dialog opens where you can choose
the storage location and where you can specify a name for the layout file.

[ I [# || = | EAPTDocs\Testjobs\HDCity-36Pages-Ad\Layout - O %
Haome Share Wi e a

* E & cut | x @ ] 2 Mew item ~ [ open - FHselectal
] Copy path « ) ﬂ Easy access = DEdit EE Seledt none
Pin to Quick Copy  Paste Mowve  Copy Delete Rename Mews Properties

access [F] Paste shorteut toT tov falder

EE Invert selection
Clipboard Qrganize Mews Open Select

“ v A D, » ThisPC » E_Data(E) » PTDocs » Testjobs » HDCity-36Pages-A4 » Layout ~ @ Search Layout pel

~

¥ o E Data (E) ol Name Date modified Type Size

> SRECYCLEBIN ) SM52_21_36pages,jdf 6/23/20171:13PM  Job Definition For... 36KB

> |] Common Services @ SM52_2x1_3Bpages_Marks.pdf 6/23/2017 1:13 PM Adobe Acrobat-D... 20KB
> || db_backup
[ el
> |] HD_Service
> || Installer
> | | Prinect Portal Data
> || PTConfig
v |] PTDocs
> | | CxF-Dateien
> D, Export
> || Extemnal_HF
| | PDF-Marks
v || Testjobs
|| 4up_FB_ID_Submit
D, BusinessCards
> || data
D, Diverse
» || Golfstory-16Pages-5C-A4
> D, HD_City_Brochure
~ | | HDCity-36Pages-Ad
|| Layout
| | PDF
» || HDTest-20Pages-4C-Ad v

2items  State: @R Shared =
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To quickly identify the layout file in the Prinect workflow, save the layout file as
"SM52_2x1_36pages.jdf* in the "PTDocs\Testjobs\HDCity-36Pages-A4\Layout" folder of the Pri-
nect server (see section "Storing Job Documents on the Prinect Manager Server", page 51). The
file name extension ".jdf" is added automatically. Prinect Imposition Editor always saves the job
files in the "Job Definition Format" with the extension ".jdf". In the Prinect workflow, this file for-
mat is also required for sheet layout files. At the same time, a file named "SM52_2x1_36pag-
es_Marks.pdf" is created that contains the marks defined in the layout template.

This completes creation of the sheet layout for use in the Prinect Manager. You can now quit Imposi-
tion Editor and Acrobat.

Creating and Editing a Job Interactively

All prerequisites for creating a new job are now being met.

Prerequisite: All the prerequisites required for creating a print job in the Prinect Manager
are now listed once again below:

- Job file: HD_City.pdf
- Sheet layout: SM52_2x1_36pages.jdf
- Customer: HD Printshop

- Sequence templates: "Group_Template_HDCity" group template

Create a New Job

Special characters in job names
Note: The following characters must not be used in job names:

% T s < > o~ ]y~ N

1. In the Prinect Cockpit, go to "Jobs", mark "PRJOBS" (1) in the job list and click "New Job" (2).
The "Create new Job" dialog opens:
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2. This dialog has four views that you can go between with "Next" or "Back". First fill out the boxes
in the "Basic job data" view:

- Assign a job number. You can take the job number, for example, from the job ticket of a
customer job. Job numbers must be unique in the Prinect system. This means that each
job number can be assigned only once. In this example, we will assign "HDO0OO1" as the
job number.

- Your next step is to assign a job name. Job names as well must be unique. When you go
to the "Job Name" box, the job number is copied automatically to this box. Heed the
above notes on characters that must not be used in job names! You can use the job num-
ber as a prefix for the job name or overwrite it. We will assign "HDO001_HDCity" as the
job name.

- In the "Documents" box you can now assign the documents (supplied by the customer)
to the job. You can also do this step later in the created job. We will not assign any doc-
uments at this point.

- By default, "Job Group" and "Job Home" are linked. This means that if you define a new
job group, a folder of the same name will be created automatically for this job group. We
want to create a new job group and click "Change". The "Select Group" dialog opens.
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%] Select Group *

Select Group

Select a group! You can add

o

Job Group: /PRJOBS/MyPrintshop

3. Disable "Start Job" and "Maximize Job View".

4. Click "Next" to open the "Customer Data" view.

64

Click the plus sign in the lower part of the
window. A new input box displays. Enter
"MyPrintshop" as the group name in this box
and confirm the dialog with "OK". The
"Select Group" dialog closes.
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5] Create new Job >

Customer Name:
Customer 1D:

Mickname:

Customer Job 1D: HDO001

Customer Job Mame: |HDO001_HDCity

Next == Cancel

5. Select "HD Printshop" in the "Customer Name" list box. This item is taken from customer admin-
istration of the Prinect Manager. "Customer ID" and "Nickname" are also taken from there.
"Customer Job ID" and "Customer Job Name" are copied from the basic job data you defined
beforehand. You can overwrite these items if you have other customer job data that differ from
the job data set in the Prinect Manager. We will leave these items as they are.

6. Click "Next" to open the "Processing” view: In this view, you can add prepared sequence tem-
plates to the job. Click "Add". The "Select Templates to Add" dialog opens:
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] Select Templates to Add *

Find...

<3 Group Template

Aualify
Interaction
b1 + POFEdIt
b1 2y Prepare
b-C1°2 CopyPDF
p-C1 & CopySurfacePDF
p-C1 & AutoPage
b2 mblePDF
01 & PageProof
b1 47 PageQutput
b1 & PagePrint
P01 9 AutoS
b3 ImposePDF
p-C1 & SendBookletPDF
C1 & ImpositionProof

7. Select "Group_Template_HDCity" and click "Add". The group template contains all the sequence
templates needed for processing this job. Leave "Save as default" disabled.

5] Create new Job >

mer Data Frocessing Seheduling

You can ign sequence templates or group templates to the job.

=1 Group_Template_ HDCity

as default

Hext =>
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8. Click "Next". The "Scheduling" view opens. In this view, you can enter a due date and assign a
priority. Leave these settings as they are. Enter "36" in the "Pages” box. Enter "5000" in the

"Delivery quantity" box. These details are for planning only; they do not affect the actual pro-
cessing of the job.

] Create New Job >

Basic job data Customer Data Frocessing Scheduling

You can define settings for job planning.

[ SetDue Date: Jun 11,2018

Responsible: English
Job type: Production
Job Priority: Mormal

Tup:

Delivery quantity

9. All the data needed for creating the new job are now entered. Click "Finish".

The new job is created and opens in the "Job" window. Double-click the caption bar of the "Job" win-
dow to maximize the width of the window. The view in which a job was last open displays at first. You
can switch the job view at any time.

Edit a New Job

Preparatory Settings

In the top left corner there is an icon with a small arrow pointing down. This arrow represents a list
box for toggling between the sections:

+ "Product Description"

Processing"

Properties”
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+ "Colors" and

+ "Printing Process".

This lets you define preparatory settings for the print job. We are now going to set up the parameters.

- Note: If you click the star beside one of the icons, the icon also displays in the workflow bar
to the right of the "Product Description" icon. You remove the icon from the workflow bar
by clicking the star in the list again.

Product Description

de | Edit | View | Job | Tools | Help |

D B B BB B

HEIDELB=R

x 4+

Name: HDOOO1_HDCity  Number: HDO0O1

HD0001

Product Part...

6/12/187:08 AW There are new messages: 1 M3

In the "Internal Comments" box, you can type information that can help to later identify the print job.

= Note: Double-click the "Notes" button (1) to open the "Notes" window where you can enter
comments about the job. These comments are retained while the job exists in the Prinect
Manager. The "Notes" window exists in its own right alongside the "Job List" and "Job" win-
dows and you can close or expand it at any time. You can use the Notes, for example, to
convey important information about the job to other processing stages (press, finishing).
You will find more details about handling the windows in the "Jobs" section and about the
Notes function in the Online Help of the Cockpit (F1 key).
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Processing

HDO0O1_HDCity HDOOO1

(4 ., 0 =3 “ I ,‘f/ w 0 ;U 0 ?0

Processing cAD Documents Imposition Precutting Print Digital Printing  Sheetfinishing Product History

Pa D

0 I 0 I 0 I 0 0

2 g [z} b B2 e £ e, 3 =
@ @ @2

In this view, the processing sequences necessary for the job are added and configured. An existing
group sequence was assigned to the print job when it was created; for this reason, the sequence is
shown here. With the "Add Template" button, you can add more sequences or group sequences if
needed.

As the existing group sequence contains all necessary process steps, we are going to leave the set-
tings as they are.

Properties

m
Overview Name: HDOOO1_HDCity  Number. HD0O0O1 Ci Name: HD Printshop lew > 'l
) o ) ;
Z D) L)@@ ) @) ® 8OO =
Properties GAD Documents. Tups Imposition Proof Precutting Digital Printing Sheetfinishing Product History
14.04 L

1404

English

Internal Comments

In this view, you can define or inspect certain properties of the print job such as Due Date, Priority or
planned quantities (Delivery quantity, Planned pages). Delivery quantity and planned pages were
defined when the job was set up. Leave all other settings unchanged.
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Colors

B 2 ) 00 O
Print

t Digital Printing  Sheetfinishing Product

In this view you can define how the Prinect Manager is to process the colors of this print job. You can,
for example import spot colors, define new spot colors or determine how certain spot colors are to
be mapped to CMYK process colors. You can find details about these options in the Online Help of
the Cockpit (invoke with the F1 key).

= Note: You can use Prinect PDF Toolbox, for example to find out which spot colors are
defined in the original PDF files of the print job. To do so, open the PDF files in Acrobat (not
from within the Prinect Manager workflow) and invoke PDF Toolbox: Plug-Ins > Prinect
2020 > PDF Toolbox. Use the "Separation Control" and "Color Management" tools, to find
information about the separations and color definitions in the PDF.

In this step, you will check whether the documents you added have spot colors. To print with CMYK
process colors only, you must map spot colors to process colors. Normally, the PDF files contain the
"recipes"” for spot color replacement. Below, we will show how you can define or modify a spot color
replacement in the job settings.

1. Click "New Color".

A new entry is added in the list below the colors.

2. Type "Silver".

Leave the entries in the "Source" (= Job), "Destination" (= Output), "Marks" (= Automatic),
"Type" (= Normal) and "Usage" (= Printing Unit) columns unchanged.

3. If necessary, scroll to the right to edit the other columns, and type the following color values:
C (CYAN): 8, M (MAGENTA): 0, Y (YELLOW): 9, K (BLACK): 19.

4. Leave the other color settings as they are and click "Save".
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[}

Digital Printing  Sheetfi

Printing Process

In this view, you can define to print the print job with a consistent output profile and with a consistent
process standard.

ame: HDOOO1_HDCity  Number: HDO0O1 me: HD Printshoj ® Modified

wie % ) @) w G i

cAD t Digital Printing  Sheetfinishing Product

Change...

Change...

</ Conflict Type

1. Click "Change..." (1) next to the "Output Profile" box. A file selection dialog opens, showing by
default the "ICC Profiles" in the "SysConfig > Resources" folder on the Prinect server. This folder
contains the pre-installed ICC profile files of the Prinect server. We recommend saving custom
ICC profile files here as well so they can be accessed easily.

2. In this context, we need a press output profile and therefore go to the "HDM Offset 2007" sub-
folder of the "Printer" folder. Select the "HDMcoated.icc" profile and confirm with "Select...".
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%] Prinect Cockpit *

Prinect Meighborhood  Computer: | KIE-CEVPNSERVOA -

Lookin: £7 HDM Dffset 2007 CJ iy 41

Name
EI HDMcoated_cpy_matticc S
[/ HDMcoated S Profile Description:  HDM Coated U340 K95 9-5

EI HDMcoated_¢ ’C ( Lab

| Jevice Color Space:  CMYK

ICC Profile: HDMcoated.icc

[ HDMuncoated_G50.i

N ) Date: Jun 11, 2007
(1 HDMuncoated.icc

File Size: 1MB

File name: HDMcoated.icc

Files of Type: | ICC Profiles (icc, .icm)

3. Click "Change..." (2) next to the "Process Standard" box. The "Select Process Standard" dialog
appears:

Select Process Standard *

IS0 12647-2_2007 HOM_BB

| 1 (glossy coated)

4 {uncoated)

Cancel

4. In the "Process Standard" list box, select "ISO 12647-2_2007 HDM_BB" and "1 (glossy coated)"
in the "Paper Grade (1SO)" box.

5. Confirm the dialog with "Apply".

The "Consistency Check" (1) table shows whether or not the selected parameters "Output Pro-
file" and "Process Standard" comply with each other. A green dot is shown next to each test cri-
terion if everything is OK.
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® Wodified

)

Digital Printing  Sheetfinishing Product

Consistency Check

1 = parameter &

In our example, a warning is displayed for the "Press Profile Color Space" (2) criterion. In the
pertaining columns, you can see that there is a press profile color space conflict: the expected
color space (black, cyan, magenta, yellow) differs (seemingly) from the existing color space
(CYAN, MAGENTA, YELLOW, BLACK). You can ignore this warning because the two entries
describe the same color space and differ with regard to small/capital letters and the order of the
color names only.

6. Save your settings with "Save".

This completes the parameter setup of all preparatory settings.

"Documents” Step

In this step, the document files that will be edited and finally printed are copied to the Prinect work-
flow.

[} )
v JE 2 e e SB[ O =
CAD Documents 1ups Impaosition Proof Precutting Print Digital Printing Sheetfinishing Product History

Default Find Q]
| Modification Date ile Size % |Extension 3| Pa < | Comment < “a=
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Add documents to the job with the "Add Files" button

To add the document PDF files to the job, you can either drag-and-drop the files from Windows
Explorer to the window (1) or you can open a file selection dialog with the "Add Files" button (2).

1. Click "Add Files" (2). An appropriate warning appears if the job is not yet started. Confirm the
dialog and the job starts. The "Add Files" dialog first displays the content of the "PTDocs" folder
on the Prinect server.

2. In this folder, go to the "Testjobs" folder, then to the "HDCity-36Pages-A4" subfolder and after
that to the "PDF" subfolder.

4] Add Files *
Prinect Meighborhood Computer. | KIE-CEVPNSERVO1 -

Look in: £1 PDF 5 o o

Name = % | Modified = | Attributes

0

File name: HD_City. pdf

Files of Type: | 1up Sizes (.eps, .pdf, .jpeq, .jpag, Aiff, zip, 1if .ps)

»  Advanced Options

3. Highlight the "HD_City.pdf" file and click "OK".
A dialog first displays, asking you whether the file is to be copied or a link created. Click "Copy".
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ize 2| Extension

170MB | PDF

Selection: 0 Documents

Add documents using drag-and-drop

As an alternative to the "Add" button, you can also add PDF documents to the "Documents” step by
dragging-and-dropping them from a Windows Explorer window (or Macintosh Finder window):

1. In addition to the Prinect Cockpit, open the Windows Explorer (or the Macintosh Finder) and go
to the "PTDocs" folder on the Prinect server. In this folder, go to the "Testjobs" folder, then to
the "HDCity-36Pages-A4" subfolder and after that to the "PDF" subfolder.

ame: HDOOO1_HDCity  Number: HD0OO1

(2

CAD

= Volume (D3

= Volume (D:)

2 Network

=4 Homegroup

fitem 1 item selected 170 MB

2. Mark "HDCity.pdf", drag it holding down the left mouse button to the "Documents” area in the
open job or to the "Documents” icon and let go of the mouse button. Adding documents using
drag-and-drop to the step icon works even if the step is not open at that moment.
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PDF

ame: HDOOO1_HDCity  Number: HD0OOY

=

A
7" Ad
oo mtERTR

ca
Fum

f

< status <[ Modification Date

Date modi

6/23/2017

i Local Disk ()
= Volume (D9

= Volume (D:)
= Network

=4 Homegroup

Titem 1 item selected 170 MB

View details about job processing

Because the job was activated before you added the files, the PDF document is processed immedi-
ately by the "Qualify" sequence. When processing is finished, the progress bars turn yellow, and has
a "Warning" sign.

1.

2.

76

You can view the warning details by opening the Preflight Report that was created during pro-
cessing. Mark a document item (2), right-click to display the context-sensitive menu and select
"Properties”. An additional information pane opens on the right:

ame: HDOOO1_HDCity  Number: HDO0O1

400

cAD

-A4PDFHD_City.pof

Selection: 1 Document

Note: In the workflow bar, small arrows indicate which step can be done next (1). Depend-
ing on what stage your job is at, several steps may be possible next. A tooltip shows you
which action is possible in each case.

Move the scrollbar (3) fully to the right until you can see the column for the Qualify sequence.
Click the document icon in this column (4). Acrobat opens with a PDF file containing the Pre-
flight Report:
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H=ID=LB=RG
Document overview
File name: HD_City.pdf
Title: 38170 HD Heute combi_dt demo
Application: QuarkXPress Passport.: AdobePS_8.7 8.7.0
Producer: Acrobat Distiller 5.0.5 (Windows)
Author: Stolz
Created on: 04/04/2003 02:25:11 PM
Date Modified: 06/23/2017 11:14:37 AM
File Size: 170.8 MByte / 174903.9 KByte
Trapped: Mo
Output Intent: -
POFX Version: -
PDF Version: 1.6
MNumber of pages: 36
MediaBox: 709.00 x 992.00 pt
TrimBox: 595.28 ¥ 841.89 pt
Summary ¥ Error . Warning = Fixed @ Info
& Document - - - -
@ PDF/X - - - -
& Pages - - - -
r. Colors - 144 - -
& Fonts - - - -
& Images - - - -
@ Content - - - -
Colors

. Maximum dot area 204% is above the 200% threshold #1 (1)

L. Maximum dot area 210% is above the 200% threshold #18 (17,35)
t. Maximum dot area 258% is above the 200% threshold #2 (11,29)
L. Maximum dot area 260% is above the 200% threshold #2 (6,24)

L. Maximum dot area 267% is above the 200% threshold #2 (7,25)

L. Maximum dot area 269% is above the 200% threshold #2 (12,30)
r. Maximum dot area 284% is above the 200% threshold #2 (9,27)

r. Maximum dot area 286% is above the 200% threshold #2 (7,25)

r. Maximum dot area 287% is above the 200% threshold #2 (5,23)

r. Maximum dot area 296% is above the 200% threshold #2 (16,34)
r. Maximum dot area 298% is above the 200% threshold #2 (7,25)

£ Maximum dot area 300% is above the 200% threshold #2 (11,29)
£ Maximum dot area 301% is above the 200% threshold #2 (7,25)

r. Maximum dot area 303% is above the 200% threshold #2 (6,24)

£ Maximum dot area 307% is above the 200% threshold #2 (13,31)
t. Maximum dot area 310% is above the 200% threshold #4 (12-13,30-31)
£ Maximum dot area 316% is above the 200% threshold #2 (12,30)
L. Maximum dot area 320% is above the 200% threshold #2 (16,34)
L. Maximum dot area 323% is above the 200% threshold #2 (11,29)

Prinect PDF Report 19.00.023 -1- 06272018 02:31:52 PM

In the report you can see, for example, that the warnings refer to the colors of the document file:
the maximum dot area is above the permitted threshold of 300%.
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As these messages are warnings only, you can continue processing the document if these warn-
ings do not affect the desired output quality. If this is the case, you ought to recreate the original
PDF document.

Close the Preflight Report and also the "Properties" view by clicking "Close" (4).

"Pages" Step
Go to the "Pages" step.

>)
7 v b B =) / =) 3 /
& ) 2 ) @ W T i 2
Processing Dotuments ages Impositian Proof Plates Precutting Print Digital Printing Sheetfinishing Product History

3 4 5
B ol Fe n Coun Pa
SPLA
ame

ssi.. & Gang Job. 2| Modification Date 3| Page Colors /1up Col... | TrimBox Offset rimBox [ Rotation
': it to: 1
Proof_HDCity 2 & H y.p ) 0 PM
PM
PM
PM
PM
PM
PM
PM
PM
PM
PM
PM
PM
PM
PM
PM
PM

aty
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4
4

The list contains only one item at first: "Assign Count: Not Assigned" (1). Click the small triangle pre-
ceding the item to expand the list of all 36 pages contained in the job. Double-clicking a separate
page will open the respective document in Acrobat where you can, for example, once again check the
contents.

Assigning Pages to a Page List

In the Prinect Manager, the document pages must be assigned to a "Page List" before they can be
output. A page list is a group of "page placeholders", i.e. empty page boxes that are filled with the
document pages by assigning them. You can assign the pages to a page list as follows:

+ by creating a new page list and assigning the pages.

- by assigning the pages to a sheet layout. In the Prinect workflow, sheet layouts already come
with page placeholders that represent a total of one page list.

can assign document pages automatically to an existing page list as soon as the document
files are added to a job. For this to be done, the file names of the PDF documents are com-
posed by a predefined pattern and given certain delimiters. When these files are added, the
file names are interpreted and used for assigning pages or page ranges automatically to
page list placeholders. This functionality is set up in the "Qualify" sequence in the "Automa-
tic Page Assignment" step. You can find more details about this in the Online Help of the
Cockpit (F1 key).

Note: If a Prinect Automation Pack is licensed for your Prinect Manager installation, you
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As the assignment to a sheet layout is not necessary for the page proof (this is done in a later step),
we are going to create a new page list:

ame: HDOOO1_HDCity ~ Number: HDOOO1 ~ Customer Name:

)
RZ00 B =3 2 = j/ w i
- a5 oo 2

CAD t Digital Printing  Shestfinishing

sign Co... 3| Page Colors /1up Colors 3/ Process Colors 3 Production Approval Status 3

1. Click the "Page Lists" button (1) to go to the "Page Lists" view:
2. Click the "New" button. The "Create Page List" dialog appears:

% Create Tup List it

Product: End product

Mame: PL_HDCity

olze:

ok ] cancal

3. Fill out the dialog as shown (Name: PL_HDCity, Start =1, Size = 36) and confirm with "OK". The
new page list appears as a drop-down list.

4. Now go to the assignment view by clicking the "Show page list assignment" button (1) and the
"Show Thumbnails" button (2):
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ame: HDOOO1_HDCity  Number HD0001  Cu

400

NENEEE

This view shows the document pages to the left, and the (initially empty) page placeholders of
the page list to the right.

5. In principle, you could now assign each separate page to a page list placeholder with drag &
drop. You can apply this method if you need a page sequence in the page list differing from the
sequence in the original documents. In our example, we want to accept the original sequence
for the page list. For this reason we will select all original pages by group selection (click any
page and press Ctrl + a) and drag-and-drop the selection to the page list placeholders.

L)

Digital Printing  Sheet finishing Product

LI LLLLI
L L L N

Selection: 0 Page Positions

6. All pages are assigned in the original sequence of the page list now:
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Number: HD00O1

(2 3 ; o) )

cAD ocu n o rint Digital Printing  Sheetfinishing Product

Page output

At this point, you can print the assigned pages to the connected page proofer to check the color set-
tings.

1. In the page list (right pane), select the page(s) to be printed to the color proofer (multiple selec-
tion is possible).

The proof output (like any other output as well) is triggered in the Prinect workflow by appropri-
ate elements (in this case the document pages) being submitted to an output sequence (in this
case the "PageProof sequence").

2. Holding down the left mouse button, drag the marked pages to the "PageProof HDCity" item in
the "Submit to" group.

x o+

Name: HDOOO1_HDCity ~ Number: HD0001 ~ Custon

[ R : [ 50 &7

cAD it Digital Printing Sheet finishin;

Alternatively, you can also click "Submit" (only available in the pages view (1)) or hit the F12 key
on the keyboard.

Note: You can toggle between the assignment view and the page list view with the F9 key.

Prinect Manager - Quick Start 81



Manual Creation of a Print Job

The "Submit Elements" dialog opens:

] submit *

Submit 36 Page(s)

Suppress nonsupported sequences

Priority Mormal » Version:

Print Amount Positions: I:l

b Details

P Scheduling

Cancel Add Sequence...

3. The sequences that are suited for the selected elements are offered in the upper section (pro-
vided the option "Suppress nonsupported sequences” is enabled). Highlight the "PageProof H-
DCity" sequence (1) and click "OK".

OUENEWN| Name: HDOOO1_HDCity  Number: HDOOO1 ~ Customer Name: HD Printshop processing [ [0

(>
&l O 7 =X A T 3 / -
g e v EPED i) el SR T e =

1
) [g)| | =/ Assioncount < Page Assignment ¥ [Fna Q
& i C&

Name 2| Rotation | scale < |Type | Preflight Status (Pre... %/ Preflight Status (Qual... > | Assigned 1/
‘Submitto [

(& 70mm
70mm
70mm
70mm
7.0mm
70mm
7.0mm
70mm
70mm

7.0 mm

7.0 mm

7.0 mm

7.0 mm

70mm

7.0 mm

7.0 mm

romm |0 100.0/100.0
“

4. To check the progress of the output, go back to the "Pages" (1) view, expand the page list and
move the image section until the "Status" column can be seen.
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“Imposition" Step
In our example, a layout was created with Prinect Imposition Editor (see section "Creating a Layout”,
page 53).

Add a Layout
To add this layout to the job, proceed as follows:
1. Go to the "Imposition" step and click "Import" (1).

0 Note: You can also drag-and-drop layout files from a Windows Explorer window (or Macin-
l tosh Finder window) to the "Imposition" step, either by dragging them to the layout window
or to the "Imposition" icon (see also section "Add documents using drag-and-drop", page

75).

W X+

OUENEWN| Name: HDOOO1_HDCity Number HDOOO1  Customer Name: HD Printshop

(2

< Production Ap

The "Select Layout" dialog opens:
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) Select Layout *

Prinect Meighborhood Computer. | KIE-CEVPNSERVO -

Lookin: =1 Layout

Name v | o .. | Layout Name: SM5

|__EI Cre C Jun

g
yle: Sheetwise (front and back)
Start Position: 1

i Layoutis valid
File name: SM52_2x1_36pages jdf

Files of Type: | Job Definition Format (. jdf)

2. Inthe "Look in" list box, go to the "PTDocs" folder of the Prinect server. In this folder, go to the
"Testjobs" folder, then to the "HDCity-36Pages-A4" subfolder and after that to the "Layout" sub-
folder. Select the "SM52_2x1_36pages.jdf" layout file in the file list. You can view details about
the layout settings in the "Select Layout" dialog. It also indicates whether or not the layout is
valid. This information is important because an invalid layout cannot be used in the Prinect
Manager. Confirm the dialog with "OK".

The "Import Layout" dialog opens.
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] Import Layout *

Product Parts =) & End product

File name:
Layout Mame:

[ Proof Layout

[ Force unique Sheet Names in the Job

[ Create Mew 1up List

Assign 1Up Li
& PL_HDCi

1 show assigned 1up lists of other layouts and levels

Sequenc

Sequence Mam

3. Because we had already created a "PL_HDCity" page list and this page list matches the layout,
we can use this page list. For that reason, we will leave the "Create New Page List" option dis-
abled. We recommend enabling this option if you do not have a page list so far. We will leave
the other settings as they are and click "Import".

4. A warning could appear before the layout is imported:
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Warning it

4 Warnings occurred during import of the layout.

Explanation:
For more details open the single warning items.

Msg.LaycutlmportWarning
w Details

4

This warning informs you that the paper data of at least one sheet is incomplete. Click "OK" to
import the layout in spite of the warning. Next, a note appears that recommends running the
Planning Assistant. Wishing to work without the Planning Assistant in our example, we answer
"No" in this dialog.

ame: HDOOO1_HDCity  Number: HD0OO1

LR g3 2 0 ~ 5% /R L]
o) . oo Print Digital Printing ~ Shastfinishing Product
e Z] Default

% Paper

The layout is then shown in a list view. In the "Page List" column, you can see that the pages are
already assigned to the "PL_HDCity" page list.

Assigning Pages to the Layout

1. Normally, the single pages must now be assigned to the page placeholders of the layout. You
assign them as described in the section "Assigning Pages to a Page List", page 78. But because
the pages are already assigned to the "PL_HDCity" page list and because you want to keep the
order and number of pages, you do not have to reassign the pages. To check your assigned data,
click the "Layout Assignment View" button (1) to view the assigned data. Now expand each of
the elements in the right window section and click the "Show Thumbnails" button (2) to view the
page assignment.
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2. If necessary, you can also assign the pages separately to the various placeholders and, by doing
so, define the page order in the layout as you wish.

You can then check the imposed sheets with an imposition proof.

Print Imposition Proof
Basically, you have the following options for starting output of an imposition proof:

+ In the "Imposition" step: Submit with drag-and-drop, page 87

+ In the "Proof" step: Submit with "Submit" button, page 88

+ In the "Proof" step: Submit with drag-and-drop, page 90

In the "Imposition” step: Submit with drag-and-drop

1. Mark the relevant layouts and, with the left mouse button held down, drag the mouse cursor to
the icon of the "Proof" step. A list of all sequences available in the "Proof" step displays below
the icon, in our example, the "ImpositionProof HDCity" sequence.

2. When you position the mouse cursor on this item and let go of the mouse button, the selected

layouts are submitted directly to this sequence.
Note: You can add a new sequence template to the "Proof" step if you keep the "Ctrl" key
pressed down while you are dragging the documents. The selected layouts are processed
automatically by the new sequence.
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[ Name: HDOOO1_HDCity ~ Number: HDO0O1 ier Name: HD Printshop.

G woo i MERRE T W el e )

Imposition_dff Print Digital Prining Sheetfiishing Praduct History

Processing CAD Documents
O & Product (] 7 s Jl £8 “impositionProof_HDCity A

~ & FB002 (1)

~ & FB003 (1)

Planning.

In the "Proof" step: Submit with "Submit" button

1. Go to the "Proof" step by clicking that icon. To check or to continue editing, you can use various
views:

The sheets are shown in a list view first. You can inspect the layouts, the sheets, and the front
and back by expanding each of the items in the list.

W x  + v mn

OUENEWN| Name: HDOOO1_HDCity  Number: HDOOD1  Customer Name: HD Printshop Processing [

—
& 0 7 7 1 f T = 3 [ -
8 (30 [p Yol ) & : D S g )
Processing CAD Documents Pages Imposition Proof Plates Precutting Print Digital Printing Sheet finishing Product History

= | & Product & " 2 Layout & 1 & Sheet & ~ | Bl [oefaut -
& surface <] status [ Production Approval Status % Customer Approval Status % | Planned Amount <[Page List <|[Piate size

Submitto ~ & Endproduct ) 18 18
#. “ImpositionProof_HDCity

» & FBOO1

Click "Separations" (1) to go to the separations view.
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Edit Plate ID

In this view, you can check the separations contained in the documents. Click the button "Lay-

outs" (2) to go back to the layout view:

OUENEWN| Name: HDOOO1_HDCity Number: HDOOO1  Customer Name: HD Printshop
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Processing

Submitto:

ositionProof_HDCity
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Digital Printing

processing [ I
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Shest finishing Product History
~ B

Click "Show Thumbnails" (3) to show the surfaces as thumbnails. Click "Show List" (4) to go

back to the list view.

2. Mark the whole end product, a single layout or a sheet and click "Submit". The "Submit" dialog
opens. The "ImpositionProof HDCity" sequence is set by default.
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7] Submit X
Submit Layout Parts

&? 1 & The TrimBox o
HD_City.pdf -

Suppress nonsupported sequences [ | All Sequence Types

Priarity Marmal w» \ersion:

Print Amount Paositions: I:l

P Details

»  Scheduling

El Cancel Add Sequence...

Confirm the dialog with "OK". Proofing starts.

In the "Proof" step: Submit with drag-and-drop

1. Switch to the list view, if necessary (1):
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HD00O1

(2 = i = 59 e

CAD Impasition Digital Printing  Sheetfinishing Product

t

2. Mark the layout, a sheet or a surface (front or back). As we want to output the entire booklet to
the form proofer, we will select the "SM52_2x1_36pages" layout and drag-and-drop it onto the
"ImpositionProof_HDCity" sequence. In our example, a warning displays. In this case, we ignore
the warning and confirm the dialog with "Continue" each time.

ame: HDOOO1_HDCity  Number: HD00O1

(3 & ‘ ( 20) &7 e e
oo : P owtipming | Swetmsnng Pt

= | & Product & 1 £ @ Sheet & ~ | Bl [ peraut -

& surface atus % |Production Approval Status + | Customer Approval Status % | Planned Amount 2| Page List < Piate Size

Output starts. A progress bar indicates the processing status.

When output is complete, you can check the result on the printed proofs.

Sheet preview in Acrobat

You can also open the imposed sheet layouts as a preview in Acrobat. To do this, go to the Layouts
view, mark a layout item in the list and select "Layout Preview" in the context-sensitive menu:
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m
Name: HDOOO1_HDCity ~ Number: HD00O1  Customer Name: HD Printshop >
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The Prinect Imposition Editor opens as "Layout Preview" in a separate Acrobat window showing the
sheet layout:

B Layout Preview: HDO002_HDCity - SM32_2x1_36pages - Prinect PDF Toolbex 2020 Imposition Editor - [m] X

Ao o FO@[m

e Y

Go to the "Plates" step if the result of the imposition proof is OK.
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In this step, you can refer to the following views: "Layouts"”, "Separations”, "Show Lists" and "Show

Thumbnails" (also refer to the information

regarding step ).

You can also open the Layout Preview (also refer to the information regarding step ).

[ Mame: HDOOO1_HDCity ~ Number: HDO0O1  Customer Name: HD Printshop
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Shestfinishing Product History
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| Page List

To start CTP output, expand the "End product” item and drag-and-drop "SM52_2x1_36pages" (1) onto
the "ImpositionOutput_HDCity" sequence. You can also click "Submit" and select the "ImpositionOut-

put_HDCity" sequence. CTP output starts.

After successful imaging, all printing plate items are given the status "OK".
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Start printing

When platemaking is finished, go to the "Print" step. The "SheetfedPrinting" sequence starts auto-
matically because we linked the "ImpositionOutput" and "SheetfedPrinting" sequences beforehand in
the group sequence template used. In the print shop, the imaged plates must be loaded to the press
and printing started on the press.

[ ame: HDOOD1_HDCity ~ Number: HDO0O1

& 0 W0 ; 3 / 0

Processing nis roof jates re rint igital Printin et in roduc History

2| Work styie

In the "Print" window, you can toggle between the "Print" (1) and "Operations" (2) views. This step is
mainly used to check the press settings you can make in Prinect Cockpit.

In the "Press" view (1), you can click the "Properties" button (2) to view details about the press job
properties:

Name: HDOOO1_HDCity Number: HD0001  Gustomer Name: HD Printshop

L4

< | Back Colors % | Plate Size <| Paper size | Plannedrs

In the left window section, you can select the entire layout or individual separations. Depending on
your selection, the right window section shows information regarding the selected item. You can find
details about these details in the Online Help of the Cockpit (F1 key). Click "Close" to close the Pro-
perties view again.
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Name: HDOOO1_HDCity  Number: HD0001  Customer Name: HD Printshop

Rz & g 36
s Pagss
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i° Sheet | Operation 2| Production <| versions < Front Colors % |Back Colors % | Work Style |3 sequence. g <[ setuptime 2+ |Production t.. | Duration

tiedPrinting_HD

00:0000 00000 [
»

Close Job

Click the "Operations" button (1) to go to the Operations view. Each of the press operations is shown
here. A "real" feedback of the operations from the press is possible only if the press is connected to
the Prinect Manager server, e.g. with a PressCenter Station.

"History", "Files" and "Change Order" sections

Printing on the press completes the processing of the job in Prinect Cockpit. In the top right corner of
the Job window, there is an icon with a small arrow pointing downwards. You can switch between the
"History", "Files" and "Change Order" sections with this icon.

"History" section

The "History" view lists all internal processing steps performed on the open print job. Here you can
review all job processing steps. The "Files" and "Change Order" icons also display when you click the
small arrow in the "History" icon. Click the icon you want to go to that view.

. Note: If you click the star beside one of the icons, the icon also displays in the workflow bar
to the right of the "History" icon. You remove the icon from the workflow bar by clicking the
star in the list again.
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"Files" view

The "Files" view lists all files and folders relevant for the print job. You can easily see here where any
of the files is stored in the file system.

+

Name: HDOOG1_HDCity ~ Number: HD0001  Customer Name: HD Printshop

1 % : & v/ L[]
% % ) g 7 L]
Processing CAD Digital Printing Sheet finishing Product

Name Extension File Size + | Archived S | Archive Date + | Sizein Archive
B3 Hotfolders

£3 aridtes Jobs Obyes
£ Norm g J oope
£3 PageProots N PTJobs 0byes
£ premgnirep J obpe
£1 Rendererepo J oope

oope

0yte

0byles

"Change Order" view

This view is designed for the case that a Management Information System (MIS), e.g. a Prinect Busi-
ness Manager, is connected to the Prinect Manager. Order changes are usually done in the MIS.
Details about such order changes display in this view.

Close Job

You can close the job (button "Close Job") when processing is finished. The finished job now displays
in the job list., but is not selected The job opens automatically in the "Job" window when you click it
in the job list.
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The jobs last opened are displayed by icons in the "Job" view. You open a job by clicking the job icon
concerned.

HEIDELB=RG

Show several open jobs in tabs

Open jobs display in tabs, with the job number as the tab label (1), (2). If a job is already open and

you go to another job, e.g. by clicking a different job in the job list, the open job closes and the new
job opens in the same tab. Click the plus sign to the right of the tabs (3) to open several jobs at the
same time.

Each open jobs display in its own tab, with the job number as the tab label (1), (2). Click the plus sign
to the right of the tabs (3) if you wish to open another job in a new tab without closing another job.
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W HDooO1 X x +
1 2 3
Overview Mame: HDOOuZ2_Golfstory Mumber: HDD0D2 Customer Name: HD Printshop

RZ .“,* 73 g SN F2)

Frocessing CAD Documents Tups Impaosition

Grouping: [] & Product == Layout [ ] =§0 Signature [ ] Assignment & st

en_Farbkontrollstreifen (4)
Submit to:

= *lmpositionOutput_HDO1

The recently open jobs first display as icons in the new, empty tab. Click a job icon or click an item
in the job list (the empty tab must be marked) to open the related job in this tab.

- Note: Short cut: The job opens in a new tab if you click a job in the job list while holding
down the Alt key.

This lets you open several jobs at the same time. You can go to a tab you want fast by clicking the
tab header.

A double arrow icon displays if too many tabs are open for all headers to display in the job window.

w HDOODE X w | | 2

Search by job number: | Find.. m HD000G

Recent Jobs
= Today
Mew Tab

HDOOOB
HDODO6_Sport
Last opened: Mar 26, 2018 4:46:04 PM

21 This Month
1 Last Month

When you click this icon, a menu displays, showing all the open job tabs. This is where you can select
the tab that will be shown.
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The "Close Job" button and the "X" icon on the tab have the same function: the job and related tab
close. Exception: When you close the last open job tab, a new tab with "Recent Jobs" and the Find
Job function then display.

A Note: When you close a job or a tab with an open job and open this job again at a later point
in time, the job opens in the state it had when it was closed.
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Create New Print Jobs by Copying PDF Files to a
Hotfolder.

With the Prinect Manager you can set up a print job in such a way that new print jobs are automati-
cally created when documents are filed in a folder that is set up as a "hotfolder". In this chapter we
will set up such a print job and describe how to create new jobs.

Prepare a Print Job

Prerequisite: The following requirements must be met for output with a reusable print job:
. - A Qualify sequence with an enabled and setup hotfolder option must be available.
- A special hotfolder print job template must be set up in "Administration > Hotfolder".
- A sheet layout matching the planned output format must be available.

- The documents to be output must be able to be edited without an error and their page
size must match the sheet layout. The number of pages does not have to match the page
total defined originally in the sheet layout. It will be matched automatically during out-
put.

We will use the "HDCity" booklet print job as our basis, like in the chapter "Manual Creation of a Print
Job".
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Set up a Qualify sequence for the hotfolder mode

1’ Templates

Active Criterion Machine Created on Created by Date Modified

Heidelberg

German

Heidelberg

01 = FormOutput

1. Open the "Qualify" sequence type, highlight "Qualify_HDCity" and click "Open". We will modify
this configured Qualify sequence for automated job creation and save it as a new file.

The setup section for the "Qualify_HDCity" sequence opens:

Overview ,t Templates

Qualify_HDCity (Qualify)

[ -# Hotfolder
on AllNormalizers

AllPreflightimports
ment

Outputis | intermediate result -
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Set this sequence as follows:

2. Except for "Hotfolder" leave all other options as they are.

3. Enable "Hotfolder" and set the following parameters:

- Hotfolder on | AllHoffolders

Hoffolder | $Template in @ JoblLocaton 2

(O External hotfolder location

Delete document after ng finished Arrange groups of at most 1

Create new job and pro cumentthere 3

Keep hotfolder in new job

Job group for ne ) urrent job group 8

When job number alrea 3 Create and use job with a new job number q

Automatic detection of job data from file name

a.

The file name contains File name in generated job

at position 1 | the job number ) r 5 uptodelimiter |# [0 Remove job number from file name

2 | the job name ym firsd c up to delimiter | & [0 Remave job name from file name

atposition 7 | -

In the "Hotfolder" box (1) leave the "$Template" setting as it is. This setting makes sure
that the file names of the job documents are used for the names of the new jobs.

= Note: In the "Hotfolder" box, it is also possible for you to set an "External hotfolder location”
instead of "$Template". To be able to do this, a hotfolder location must have been set in the
system settings (Administration > System). This folder must be shared. You will find more
details about this in the Online Help of the Cockpit.

b. Enable the "in...Job Location" option (2). Use this option to file the new jobs below the

"PTJobs" folder (if "$Template" is set) or in the set hotfolder location on the Prinect
server.

Enable "Create new job and process document there" (3). When this option is enabled,
new jobs are created automatically when document files are filed in the hotfolder.

Using the settings below, you define how the file name of the PDF documents will be
interpreted to create new print jobs automatically. To this end, you must change the PDF
file names in such a way that various components in the file name are separated by
delimiters and are used for job parameters. This is where you define the rules by which
the file names will be interpreted. You can find more details about the detection rules in
the Cockpit Online Help.

. Select "the job number" in the "in position 1" list box (4). This defines that the first com-

ponent of the PDF document name will be interpreted as the job number.

Enable "from first character" in the first row. As a result, all characters in the file name
up to the first delimiter are interpreted as the job number.
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Enter the character "#" into the "up to delimiter" box (5). As a result, the file name of
the filed documents is interpreted in such as way that all characters before the "#" in
the file name are interpreted as a job number and are used for the new jobs. The file
names of the filed documents must have this delimiter and appropriate characters for
the job number in order for new jobs to have a job number.

. Select "the job name" in the "in position 2" list box (6). This defines that the second

component of the file name (after the first delimiter) will be interpreted as the job name.

. Leave "from first character" in this row disabled.

Enter the character "&" into the "up to delimiter" box (7). This character acts as a rear
limitation for the job name. All the characters between the two delimiters "#" and "&" in
the file name of the filed documents are used as the job name.

Example: A document named "1234#Brochure_HD&.pdf" creates a job with the number
"1234" and job name "Brochure_HD".

In the "Job group for new job" list box (8) leave "Current job group" set. The new jobs
generated are created in the same job group as the original job.

Caution: Make sure that job numbers in a Prinect Manager environment are always unique.
A new job may overwrite an existing job if the new job is created in the hotfolder mode and
its job number matches that of the existing job! Use the settings below to prevent existing
jobs from being overwritten.

k. Set "Create and use job with a new job number" in the "When job number already exists"

list box (9). If the job number determined from the PDF file name already exists, a new
job number is created by appending an index. The new job created is given this job num-
ber.

In the "Keep existing process network" list box (10) or using "Generate a new process
network via Smart Automation if a product code is detected”, you can define whether a
new process network will be created for each automatically generated job or whether
the process network of the template job will be used for the new jobs. A process network
is a combination of print jobs, sheets or sheet layouts and sheet-processing sequences.

In our example, we will use the process network of the template job and, for that reason,
select "Keep existing process network".

4. Leave the other steps as they are and click "Save as".
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Tl Save Template >

Qualify

Template Nam

Comment:

Customer 1D ooo

New Folder...

5. Assign "Qualify_AutoJob" as the name and, if not already set, select "HD Printshop" as the cus-
tomer using "Select Customer". Confirm the "Save Template" dialog with "OK".

- Note: The "Product Codes" and "Product Types" parameters are designed for an automated
workflow ("Smart Automation") with a connected Web shop and/or an MIS. Based on these
parameters, sequences matching certain products will be used for production in an auto-
mated workflow. No data was entered in these boxes in our example.

6. Click "Close". The sequence overview displays:
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Date Modified

Note: If required, you can set up a "Prepare” sequence template and use it in the workflow.
This may be necessary, for example, if you wish to use the detailed settings of Heidelberg
Color Management or if you have to reduce transparency elements in the job documents.
You can find details about the various parameters of the sequences in the Online Help of
the Cockpit (F1 key).

Edit a group template for automatic job creation

A group template containing the "Qualify_AutoJob" Qualify sequence is to be used for the new print
jobs created. To this end, we will use the "Group_Template_HDCity" group template set up before-
hand (see "Create a Group Template", page 47) and swap the Qualify sequence.

1.  Go to "Administration > Templates" and open the "Group_Template_HDCity" group template.
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1’ Templates

a g = ! = =

age
semblePDF

ookletPDF
itionProof

Add Template

Save as...

1" Templates

up Templates

PageProof_HDC. ImpositionProof. ImpositionOutps SheetfedPrinting_H.. up_Template_HDCity
] =] @ =] lEall= a =

}-C1 « PDFEdIt
p-E1 % Prepare
Se

emblePDF
&Proof
eQutput

}-E1 & PagePrint

Add Template

Save Save as...

3. Add the "Qualify_AutoJob" Qualify sequence.

4. Leave the other sequences as they are and save the group template as "Group_Template_Auto-
Job" and close it.
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Automatic creation of print jobs

After the Qualify sequence is set up, a hotfolder job template is now created. An "external hotfolder
location" must be defined for this. A Qualify sequence with an enabled hotfolder option is also
required.

Define an external hotfolder location

To create hotfolder job templates, it is imperative that an "external hotfolder location" is defined. Pro-
ceed as follows to create an external hotfolder location:

1. Go to "Administration > System" and mark "System".

Add Job Folder... Delete

2. Click "Browse" in the "External Hotfolders Location" section.

3. Go to the "PTTransfer" folder and click "Create new folder" (1).
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lﬁ Select external Hotfolders Location *

Computer. | KIE-CEVPNSERV0 -

Lookin: 1 PTTransfer

Name = + | Modified % | Attributes

File name: WKIE-CEVPNSERVO1\PT Transfer

Files of Type: | All files

4. Name the folder "External_HF".
5. Confirm with “OK” and click "Open".
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User-defined Folder in Job Folder

& JobName

Add Job Folder...

Show Clusters

6. The external hotfolder location is defined. The green dot indicates that this folder is available as
an external hotfolder location. Confirm the change with "Save" and click "Overview".

Create a hotfolder job template

1. Go to "Administration" or click "Overview" if the administration options do not display.

Administration

Settings

JF

JDF-Import

2. Click the "Hotfolder" icon. The "Hotfolder" section displays:
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This is where you define the job templates that are intended solely for the automatic creation of
new jobs. These job templates do not display in "Jobs" so that they are not inadvertently
deleted.

3. Click "New". Input boxes now display on the right. Type in the following data:

ERVOTPTTransferExternal_HFAuto_HFO1

« Name: Auto-HFO1
- Job group for new job: with current date

+ Processing: Add the "Group_Template_AutoJob" with "Import".
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4. Confirm your settings with "Save".

Name

Nam
Folde ERV01\PTTransfer\External_HF\Auto_HF01

Job group for new job

Import...

Edit Hotfolder Job

5. The hotfolder template is set up. Click "Overview".

Create a New Job by Filing to the Hotfolder

After you prepared the job template for automatic job creation in the hotfolder mode, automatic cre-
ation of new jobs and their processing can begin.

Prepare Document File Names

Delimiters were defined in the hotfolder settings of the Qualify sequence and they can be used to fil-
ter out the job number and job name from the document file names. We will customize the file names
of the PDF documents to be output so that we have useful job numbers and job names.

We will use the "HDCity.PDF" document again as the example document. We will now duplicate this
file (with Copy and Paste) and rename it to "AJO0O1#HDCity A4&P01_P36.pdf" to meet the require-
ments for automatic job creation. Based on the set delimiters "#" and "&", a new job with job number
"AJO001" and job name "HDCity_A4" will be produced.

Create and Start a Print Job Automatically
Proceed as follows:

1. Open a Windows Explorer window and go to the folder where the "HDCity.PDF" file is located
(in the example, in the "PTDocs\Testjobs\HDCity-36Pages-A4\PDF" folder).

2. Duplicate the "HDCity.PDF" file and rename it to "AJOOOT#HDCity_A4&P01_P36.pdf".

3. Open a second Explorer window and position both windows so that you can see both of them
fully on the screen.
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4. Inthe second Explorer window, go to the "\\PTDocs\External_HF\Auto-HFO01" folder. This folder

was created by the system when you were creating the hotfolder job template. See "Create a
hotfolder job template", page 110.

I & [ = 1poF - o X 1B O = | Autor - o x
Home  Share  View ] Home  Share  View (2]
« © 4 > EDATA(E) » PTDocs » Testiobs » HDCity-36Pages-Ad > PDF v ©| | Search POF o « “ 4 || EDATA(E) » PTTnster » Etemal HF » Auto HFO! v 0| | Search Auto HFOT »
Prinect Portal Data A Name - Date modified Type Size swdefault  Name . Date modified Type Size
PTCanfiy 1 AL0DD1 $HDCity_A48PO1_ P35 pd SR 1114 AM_Adobe Aciobat-D..  174304K3 sk RE—
PTDocs T HD_City.pdf 6/23/201711:14AM  Adobe Acrobat-D, o =y %
CoF-Dateien S
PDF-Marks = Comem (@)
Testjobs = D_TEMP (D) -
4up_FB_ID_Submit o EDATAE)
BusinessCards ActiveMQ Adobe
w Commn Senices
Diver db_backup
Golfstory-16Pages-SC-Ad -
HD.City_Brochure HD_Service
HDCity-26Pages-Ad Installer
Layout Prinect Portal Data
G PTConfig
HDTest-20Pages-4C-Ad D
ImposePDF PTioh:
PTTranster
External_HF
Auto HFOT
SQLDATA
v o< > v =
Zitems  1item selected 170MB  State: @& Shared (= | otems  stte@ shared E=

5. In the first Explorer window, mark "AJO001#HDCity_A4&P01_P36.pdf" and, holding down the
left mouse button, move the mouse pointer to the second Explorer window, to above the
"\\PTTransfer\External_HF\Auto-HFO1" folder in the example. Let go of the mouse button at this

point. The file is moved. To copy it, press the "Ctrl" key at the same time while you are moving
the mouse cursor.

Go to the Cockpit again. After a while, a new job group with the date the job was created (1) and
in it a new job "HDCity_A4" (2) with job number "AJO001" (3) displays in the job list.

ame: HDCity A4 Number: AJODO1

O Vi) @)@
Documents 1ups Impositian Proof

Default

< | status
#l AJ0001#HDC,

Selection: 0 Documents

Submit Add Files... Close Job

Trmr New Job... Elements < | sequence < | RecentMessage < | Wouification Date 2 [=]
e

The job is started automatically.

Click the job in the job list, go to the "Job" window, maximize the width of the window by dou-
ble-clicking the caption bar and go to to "Processing". In this section, add other sequences as
described in section "Preparatory Settings", page 67.
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8. Continue with the following processing steps:

- "Documents” Step, page 73

- "Pages" Step, page 78

- "Imposition" Step, page 83

- Print Imposition Proof, page 87

- Start Imaging of Plates, page 93

- Start printing, page 94

9. When finished, close the job.

In this way, you can automatically generate more print jobs.
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Comparison of Controls in Prinect MetaDimension
and Prinect Cockpit

If you are switching from Prinect MetaDimension to the Prinect Manager, this chapter will show you
where to find the main Prinect MetaDimension functions in the Prinect Cockpit. The structure of this
chapter is similar to that in the Prinect MetaDimension Printmanager.

"Jobs" (MetaDimension Printmanager)

In Prinect MetaDimension, the processed print jobs or those currently in process display in "Jobs".

This section is found likewise in "Jobs" in the Prinect Cockpit. For system reasons, there are differ-
ences in the view and functionality of these job lists.

In Prinect MetaDimension, the job list has various tabs with different functions:

« "Complete Job List", page 116

« "In Process", page 116

+ "Requiring Attention", page 116

« "Completed", page 116

+ "Depot", page 116

« "Find", page 116
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» "Image Job List", page 116

You will find the equivalent of these MetaDimension tabs in "Jobs" in the Prinect Cockpit:

Complete Job List

"Complete Job List" is equivalent to the job list in the Cockpit with the "All jobs" filter setting.

In Process

The "In Process" job list is in principle equivalent to the job list in the Cockpit with the "Active" filter
setting.

Requiring Attention

In Prinect MetaDimension, this tab displays jobs where errors occurred.

There is no filter setting for this in the Cockpit, but in the job list you can sort the order in the "Pro-
cessing Status" column to show all jobs with a "Warning" or "Error" status first.

Completed

The "Completed” job list is in principle equivalent to the job list in the Cockpit with the "Finished"
filter setting.

Depot

The "Depot" job list is in principle equivalent to the job list in the Cockpit with the "Offline" filter set-
ting. The archiving function in the Prinect Manager is equivalent to the depot functionality in MetaDi-
mension.

Find

Instead of the "Find" tab in MetaDimension, there is a powerful search function (Find window or
"Find" in the context menu) in the job list and in the "Jobs" view in the Cockpit.

Image Job List

Images that are processed with the Imagemanager are managed in the Image Job List. The Imagem-
anager is needed to create low-res preview images out of high-res images (photos). These low-res
images are used during job processing in the PostScript jobs to go easy on the resources of the com-
puter and to increase the processing speed. The original images are used again only during imaging.
This process is known as "OPI (Open Prepress Interface) and is available only in the PostScript work-
flow.

The Prinect Manager works solely with PDF files (PostScript files are converted to PDFs before pro-

cessing begins). Because the PDF format gives you several ways to compress image data, a separate
module like the Imagemanager is no longer needed. For that reason, the image job list of the Image-
manager has no equivalent in the Cockpit.
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You will find options for configuration of the image size for images contained in the PostScript files in
the "Qualify" sequence in the "Images"” tab in the "Normalizing" step. In this tab, you can set with
great precision how different image formats are to be prepared.

In the "Preflight" step, you can set up various check criteria for images to make sure you have smooth
processing matching the quality requirements.

Details about a Job

In the MetaDimension job list you will find more details about a specific job by double-clicking this
job. These details are available in the following tabs:

« "Job Settings", page 117

« "Job Information", page 117

« "Job Details", page 117

+ "Halftone Soft Proof", page 119

« "Signatures", page 120

In the Prinect Cockpit, you will find details about a single job in the "Job" view in "Jobs". The job
details display in this view automatically whenever you click a job in the job list. The "Job" view must
be big enough to be able to see the contents.

Job Settings
In MetaDimension, this is where the output settings of the used Output Plan display.

The MetaDimension Output Plans are equivalent to the sequences in the Prinect Manager and conse-
quently you will find the output parameters in "Processing" in the "Job" view. The sequences used in
the job display as graphics in this section. To view or modify the various parameters in these
sequences, double-click the icon of the sequence concerned. When you save any changes you made
to the sequence setup, these changes affect only the current job.

Job Information

In MetaDimension, this is where information about general key data about the job and the job status
displays (also about any errors).

In the Prinect Cockpit, you will find this information in the open job in "Product Description”, "Pro-
perties", "Printing Process" and "History".

Job Details

In MetaDimension, this is where you can view details about the processed job, in particular about the
screen settings.

In the Prinect Cockpit, you will find a preview equivalent to the halftone soft proof in the open job in
the "Separations" view (1) in the "Plates" step. You can see the column with the name of the Imposi-
tionOutput sequence if you move the horizontal scroll bar fully to the right in the list view.
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Name: HDOOO1_HDCify ~ Number: HDO0O1  Customer Name: HD Printshop

é‘ .7| ﬂﬂas Fa wu ,"ju

Processing Documents 1ups Imposition Proof Precutting Digital Printing ~ Sheetfinishing Product

G w| # Layout & ™ & Sheet & ™ & Surface & 20 | output
1

T Separation B | Paper size < | Plate Usage. < | Modification Date  %| Usage | comment

Submitto:
. "impositionOutput_HDCity 0.0 0.0 mm
0.0x0.0mm Printing Unit

0.0x0.0 mm Printing Unit

Printing Unit
Printing Unit

Printing Unit

Printing Unit

Printing Unit

Printing Unit

0.0x0.0 mm Printing Unit

0.0x0.0 mm

0.0x0.0 mm

Selection: 1Separation

Edit Plate ID i Planning...

When processing of a separation is finished, an icon for the "Renderer" report displays in the row of
the separation concerned. You open the report window by clicking this icon (2):

ID: HDOOO1 Job Name: HDOO01_HDCity

Parameter Settings
Job Information

Color
paration Parameter
Dot Shape

maoth Elliptical
Mominal Frequenc 0
Mominal Angle B

S tion Parameter
Dot 5
Maominal Frequenc
Mominal Angle
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The details in this window can be compared to the information in the "Job Details" tab in MetaDimen-
sion.

Halftone Soft Proof

In MetaDimension, the "Halftone Soft Proof" tab displays in the processed job if the "Halftone Soft
Proof" option is enabled in the Output Plan. In this tab, you can preview the screened Tiff-B data that
are used for platemaking.

Prerequisite: In the Prinect Manager, the job must have been edited with an Imposition-
Output sequence where the "Halftone Soft Proof" option is enabled.

In the Prinect Cockpit, you will find a preview equivalent to the halftone soft proof in the open job in
the "Separations" view (1) in the "Plates" step. You can see the column with the name of the Imposi-
tionOutput sequence if you move the horizontal scroll bar fully to the right in the list view.

Overview Name: HDOOO4_RGtEST  Number: HDOOO4  Customer Name: HD Printshop

>}
o = = 5 . ;
& B g3 R 2 0 A7 /
&l ., 1 g3 H 36 B Fz . 72 “ - 0 3 w o '/ o
Procsssing Documsnts tups Imposition Procr Plates Precuting Digital Printing  Sheet inishing Product

T := Layout & W @ Sheet T % & Surface & Zll | output

@ Separation < Paper Size $ Piate Usage 5 Modification Date 3 Usage 3 Comment
Submitto: = A
.. ImpositionOutput_HDCity D OmmT

0.0x0.0 mm Printing Unit

0.0%00 mm Printing Unit

Printing Unit

0.0x0.0 mm
0.0x0.0 mm

0.0x0.0 mm

0.0x0.0 mm Printing Unit

0.0x0.0 mm

0.0x0.0 mm

0.0x0.0 mm

Edit Plate ID Submit... Planning. .

When processing of a separation is finished, a "Preview (ImpositionOutput)" icon (2) displays in the
row of the separation concerned. You open the preview by clicking this icon.
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This view is equivalent to the "Halftone Soft Proof" view in MetaDimension.

Signatures

In MetaDimension, the color separations or plate signatures generated display in this tab. This is also
where you repeat imaging of single plates if needed.

In the Cockpit, you will find a view of the plate signatures in the "Job" view in the "Plates" step. This
view lists all the signatures in the job. You can submit selected signatures, for example, to an Impo-
sitionOutput sequence for plate output or to an ImpositionProof sequence for imposition proofing by
marking single signatures and clicking "Submit".

"Devices" (MetaDimension Printmanager)

All the output devices (CTP, proofer) installed in MetaDimension are listed in the "Devices" section.
You invoke the Engine Manager (Speedway Engine Manager, Color Proof Pro, Proofing Engine Mana-
ger) for a specific device by double-clicking the device item. You configure the device in its Engine
Manager.

In the Prinect Cockpit, you will find an overview of all output devices in the Prinect Manager, with the
exception of CTP devices, in "Administration > Prepress devices". For proofers, you can open a
proofer item and configure certain output parameters (scatter proof, etc.). If "Scatter Proof" was
enabled, you can open the "Scatter Monitor" window and, for example, start scatter proof manually.

In the Prinect Cockpit, there is no direct link to the Engine Managers from the Cockpit. You can invoke
the Speedway Engine Manager, the Proofing Engine Manager or the Color Proof Pro Engine Manager
directly in the Windows Start menu or in the file system and set your data there.
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"Administration" (MetaDimension Printmanager)

This section is divided into the following tabs:

+ "Resources”, page 121

« "Configuration", page 123

« "System", page 125

Resources

This tab has the following elements:

« "Output Plan Templates", page 121

+ "Paper Stretch Compensation”, page 121

- "Page Positioning", page 121

+ "Calibration", page 122

« "ICC Profiles, Device ICC Profiles", page 122

+ "Fonts", page 122

+ "Color Handling", page 122

« "Printing Materials", page 122

Output Plan Templates
You set up various output options for the connected output devices in the Output Plan templates.

In the Prinect Cockpit, this function is covered by sequence templates. You can find the sequence
templates in "Administration > Templates > Sequence Templates". For system reasons, the sequence
templates are organized by functions and not by devices. For example, the sequence templates for
imaging to plates are to be found in "ImpositionQutput” or "PageQutput”. You will find the sequence
templates for proofers in "PageProof" or "ImpositionProof". The "FormQOutput" and "FormProof"
sequences are also available for a ROOM proof workflow (RIP Once Output Many).

Paper Stretch Compensation
You will find the settings for paper stretch compensation at two points (depending on your license):

« in the Cockpit in "Administration -> Paper Stretch Compensation"” or

- using the "Automatic Paper Stretch Compensation" application. This software starts and runs
separately to the Cockpit.

Page Positioning

In MetaDimension, page positioning templates are used to generate simple sheet imposition layouts
if no special imposition program (Prinect Signa Station) is to be used.
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In the Prinect Manager, sheet layouts are not defined in the Cockpit but are always added to the print
job (in "Jobs > Imposition"). If you just need simple sheet layouts, you can create them with the Pri-
nect Imposition Editor (part of the "Prinect PDF Toolbox" Acrobat plug-in).

Calibration

In the Cockpit, you define the settings for process calibration and linearization in "Administration >
Templates > Sequence Templates" in the ImpositionOutput sequence templates in the "Calibration"
step. The calibration data records are also created with the Calibration Manager/Calibration Tool
software in the Prinect Manager.

ICC Profiles, Device ICC Profiles

AlL ICC profiles, both standard and user-defined, are managed in "Administration > ICC Profiles".

Fonts

Font administration in MetaDimension has no direct equivalent in the Prinect Manager. The Prinect
Manager processes solely documents in PDF format and, for that reason, the required font types are
generally embedded into the PDF files. You define embedding of the font types in the "Qualify"
sequence template in the "Fonts" tab in the "Normalizing" step. You can take the fonts you need from
the Windows system font folder and/or one (or more) additional "Font Search Folders". You set the
font search folders in the Normalizing step as well.

Font search folders are folders in the file system of the Prinect server in which the various font types
are filed. If fonts in the original documents are not found in the font search folders or system font
folder, you can set whether the print job will be aborted, whether a warning will be issued or whether
this error will be ignored. Then the missing fonts are replaced by a different font.

Color Handling

In MetaDimension, you can define, for example, how spot colors will be replaced by other spot colors
or custom CMYK ink recipes.

In the Prinect Manager, you can view the colors of a job in "Jobs > Job" in "Colors" and edit them if
necessary. This is where you can, for example, also define your own spot colors or assign different
spot colors to the job. These settings always only affect the job that is currently open.

Color Tables

In the Prinect Cockpit, color tables are managed in "Administration > Colors and Varnishes".

Printing Materials

In the Prinect Manager, printing materials are managed in "Administration > Printing Materials and
Substrates”.
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Configuration

This tab has the following elements:

« "Virtual Printers", page 123

« "Ilmage Directories", page 124

+ "Preferences”, page 124

« "Drive Monitor", page 125

+ "Regional Settings", page 125

- "JDF Portal", page 125

« "Prinect®services", page 125

Virtual Printers

There are no virtual printers in the Prinect Manager because of the different concept there. In the Pri-
nect Manager, the combination of virtual printer and Output Plan is represented by appropriately con-
figured output sequence templates. For example, a CTP device is assigned to an ImpositionOutput
sequence. The output options are defined in this sequence.

In the Prinect Manager, other functions like the definition of a hotfolder are set up in a Qualify
sequence and in "Administration > Hotfolder".

Because there is no direct control through a "printer” in the Prinect Manager where document files
(mainly as PDFs) are only added, there is no equivalent to the definitions of a Windows queue or a
BSPP printer port. Jobs that are generated in a Management Information System (MIS) or in a Web
Shop can be transferred to the Prinect Manager via a JDF connection (Job Definition Format). How-
ever, this process cannot be compared with printing through a queue or printer interface because
these jobs are processed later by the Prinect Manager.

In the Prinect Manager, assigning job priorities and the time-controlled start of job processing are
defined when a print job is created. This is done by defining the due date and the earliest start date.
In an open job, you can also define a due date for each step.

You set the the time-controlled storage (archiving) of jobs and deletion of finished jobs in the Prinect
Cockpit in "Administration > Planned Tasks".

You define the creation of sheet preview images and thumbnails in the ImpositionOutput sequence.

In the Cockpit, you will find an overview of the current status of all engines in the Prinect Manager in
"Queues". Engines are hardware and software elements that run functions in the Prinect Manager.
This is where you can, for example, monitor CTP devices or proofers and stop or continue them if
needed. Stopping a queue means that the engine concerned is stopped in the Prinect Manager and,
consequently, no function can run. This does not mean that a device (e.g. a proofer) is shut down or
switched off.

In the Prinect Manager, this concept is more oriented to functions and not as oriented to devices like
in MetaDimension.
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Image Directories

The administration of image directories is not applicable in the Prinect Manager because it does not
have an Imagemanager (see section "Image Job List", page 116).

Preferences

In MetaDimension, various system settings are set up in this section:

Options

- Pause Jobs after restarting the server

There is no equivalent to this option in the Prinect Manager. The Prinect Manager has other
mechanisms that prevent imaging from running automatically if an imagesetter is not ready to
start.

+ Delete output of failed jobs

There is no direct equivalent to this option in the Prinect Manager. In "Administration > Prefer-
ences > All Users > System Healthiness", you can enable "Delete ImpositionQutput files after job
is finished" and/or "Delete proof files after job is finished" to prevent the output data of finished
print jobs from filling up the hard disks and blocking the system.

+ Generate CIP before final output

There is no equivalent to this option in the Prinect Manager. CIP3 data are always generated
before final output.

« Create IPR

There is no equivalent function in the Prinect Manager because the Prinect Manager cannot be
driven as a printer.

Depot Directory

In the Prinect Manager, print jobs are filed by default in the "PTJobs" directory on the Prinect server.
If you want something different, in the Cockpit you can define a different job location in "Administra-
tion > System" and, if necessary, user-defined folders in the job folder. This is where you can also
define an external hotfolder location. By default, hotfolders are set up below the job location folder.
See also "Define an external hotfolder location", page 108.

You can find details about the License Server in "Administration > System" after clicking the "System"
element in the tree structure.

Reprint

These parameters are not needed because the concept of reprints is different in the Prinect Manager
to MetaDimension.

Administration display

The Prinect Cockpit does not have an equivalent function for saving used screen space. Instead, you
can show or hide the various windows in "Jobs" and make each of them bigger or smaller separately.
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Network

A network adapter does not have to be defined because the Prinect Manager cannot be driven as a
printer.

Additional OPI Image Include Paths

The administration of additional image directory paths is not applicable in the Prinect Manager
because it does not have an Imagemanager (see section "Image Job List", page 116).

Drive Monitor

The drive monitor has no equivalent function in the Prinect Manager. You can view the memory utili-
zation of some storage areas with set functions, e.g. "JDF Storage"”, in "Administration > System >
[Prinect server] > JDF Storage".

Regional Settings

You will find equivalent settings in the Cockpit in "Administration > Preferences".

JDF Portal

You will find settings for the JDF Portal in "Administration > JDF Import". There is no "Connect"
option (this is needed only for clients) because the Prinect Manager operates principally as a JDF
Connector Server service.

Prinect®services

You can find details about the Master Data Service in "Administration > System" after clicking the
"System" item in the tree structure. There is no "Connect" option (this is needed only for clients)
because the Prinect Manager operates principally as a Master Data server service.

System

This tab has the following elements:

+ section "Server", page 125

+ section "E-mail", page 125

+ section "Users, Groups, Permissions”, page 126

Server

In MetaDimension, this is where the MetaDimension server services available in the network are
listed. In the Cockpit, the Prinect Manager server can be accessed in "Administration > System". All
server and engine computers connected to the Prinect Manager display in this section.

E-mail

The e-mail functionality is managed in "Administration > E-mail" in the Cockpit.
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Users, Groups, Permissions

User administration is grouped in "Administration > Users" in the Prinect Cockpit.

Sample Configuration of the Prinect Cockpit

In the "Work Mode" (in contrast to the Configuration Mode), Prinect MetaDimension runs mainly in
the job list view.

You can set the following view accordingly for the Prinect Cockpit:

Fle | Edt | View | Job | Tools | Help |

O 5% & BB B

HEIDELB=RG

Browse... New Job...

1jobselecea| &Y 2 A1 There are ne

The "Job List" and "Job" views are open in "Jobs". If needed, you can filter the job list, sort it, give it
a different structure or view certain jobs only with the help of the Search function. You can find
details about this in the Online Help of the Cockpit.

When you click a job, the content of this job displays in the "Job" view. In this view, you can open
several jobs at the same time, each in their own tab. In the "Plates" step, you can display the single
separations, matching the plates, and view details about the screening parameters or invoke the half-
tone soft proof function. To reprint single plates, mark the related separation and submit it to the
ImpositionOutput sequence (using drag-and-drop or by marking it and clicking "Submit").

We recommend using the function of automatic job creation (see "Automatic Creation and Output of
Print Jobs in the Hotfolder Mode", page 101) wherever possible.
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Example of a Prinect Signa Station - Prinect Mana-
ger Workflow

Prinect MetaDimension is frequently used in combination with a Prinect Signa Station. In such a con-
figuration, the print jobs are generally fully imposed on Prinect Signa Station and then submitted to
MetaDimension for output.

In a Prinect Manager and Prinect Signa Station setup, a different workflow is recommended where
Prinect Signa Station is launched interactively from the Cockpit.

Prerequisite: Prinect Signa Station must be installed on the Prinect server and mounted on
the Prinect Manager for this workflow. In the Prinect Cockpit, you can check whether the
setting is correct in "Administration > Preferences > Local Applications":

w = |ocal Applications
Acrobat

C:A\Program Files (x86)\wdobe\icrobat 9. 0MAcrobat\crobat exe

Plug-in enabled

Prinect Signa Station

C:\Program Files\Heidelberg\Prinect Signa Station 19\PrinectSignaStation19.exe

Version: Prinect SignaStation Version 19

In this workflow, Prinect Signa Station is used solely for creating sheet layouts. These sheet layouts
are merely imposition templates and do not contain any content pages but only the page positions,
marks, data about front and back pages, etc. The file format of sheet layouts for the Prinect Manager
is ".JDF" (Job Definition Format).

These sheet layouts are filled with the document pages in the Prinect Manager (see also "Imposition”
Step, page 83). The imposed sheets are then submitted to an ImpositionProof or ImpositionQutput
sequence for output.

Interactive creation of sheet layouts is done in the "Imposition" step:

1. Create a new print job, add the PDF documents needed for it and go to the "Imposition" step.
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x +

Name: HDOOO1_HDCity ~Number: HD0OOO1  Customer Name: HD Printshop
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Processing CAD Documents 1ups Imposition Plates Precutting Digital Printir Files

= | & Product % % == Layout % " @ Sheet % Z0 | Defautt - a
iR

& Surface % | Production Approval Status | Customer Approval Status = | Gang Job 2| Planned Amount %[ 1up Lists % Plate
« & End product 8

Planning...

2. Click "Create" (1). The "New Layout" dialog opens:
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%] Create New Layout *

Create New Layout

Layout Mame: Lay_HDCity

Create Mew 1up List

1Up List Mame: |PL_Lay_HDCity

Add>>

<<Remove

[ Proof Layout

Assign Product: S &' End product

[] Create product parts with Prinect Signa Station

pen the layout

3. In this dialog, enter only a layout name, in the example "Lay_HDCity". Leave all other parame-
ters as they are. A new page list named "PL_Lay_HDCity" is created automatically. Confirm the
dialog with "OK". A dialog named "Waiting for imposition software" displays briefly. Then Prinect
Signa Station opens.
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4. The layout named in the Cockpit (in the example "Lay_HDCity") opens as a new job in Prinect
Signa Station where you can edit it. Make sure that you only create a layout and do not paste
any contents. After you finished and saved the new layout, it is assigned automatically to the
Prinect Manager job and can be used for imposition of the content pages.

5. You can find details about editing layouts in Prinect Signa Station and about the Signa Station/
Prinect Manager workflow in the Online Help of Prinect Signa Station. You will find information
about imposition in the Prinect Manager in section "Imposition" Step, page 83.

= Note: As an alternative, you can create a new layout (without content pages) offline on Pri-
nect Signa Station and import this layout (as a JDF) to the "Imposition" step in the Cockpit.
Import is recommended whenever a layout is to be reused. You will find details about the
offline creation of layouts in the Online Help of Prinect Signa Station.
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Job List - Functionality and Icons.

Prinect Cockpit.

Cockpit - Workspaces™
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Open Job - Functionality and Icons.
Prinect Cockpit.
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Incorporate icons from the list
box into the head line
Right in addition to the parameter
T:f icons is a “star” icon. By clicking
on it, the corresponding parameter
icon is displayed also in the head
line left from the workflow bar.
Simultaneously the “star” icon is
1'5? colored yellow. A repeated clicking
on the “star” icon removes the
parameter icon from the head line.

Right Parameter Area

History - Information on the history of the single processes

%
%
C"!)(\?L

during job processing

Files - Displays the folders in the file system which are
involved in the job processing

Change order - Displays the change orders being registered
for the job

Portal Services - Configuration of the Portal Services view
for this job and the E-mail management

Group approval - Configuration of the group approval

Incorporate icons from the list box into the head line
Right in addition to the parameter icons is a “star” icon. By
clicking on it, the corresponding parameter icon is displayed
also in the head line right from the workflow bar.
Simultaneously the “star” icon is colored yellow.

A repeated clicking on the “star” icon removes the parame-
ter icon from the head line.

Changing the Width of the Win-

dows

If the mouse cursor is positioned exactly
between two windows, it will look like a double-
arrow. Now the width of the window can be
adjusted if the mouse button is held fixed.
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“Job List” Window “Job” Window System Messages Status Area News Digital Printing
After clicking on a job Here the elements (job Clicking on this icon opens Here the processing Here is notified, Terminal (minimized)
2 in the job list, this job content, control elements) the “System steps progress of the if and how Gives an overview of the

is opened in the “Job”
window.

of the selected workflow
step (in this example Digital
Printing) are available.

messages” window

current job is displayed. many nes are status of the digital printing

available. jobs.

*
Workflow Steps Counter

'-| CAD - Connection to the Package Designer | 1ups
Documents Documents
Add documents to the job

Pages/1ups - Page/1up preparation Pages/1ups

E@) Imposition Sheets
Proof Sheets
Page and/or form proof output
Plates - Plate recording Plates
Precutting
Press - Printing press output Press runs

Digital Printing
Sheet Processing Folding sheets

Product - Finishing
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